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1 Introduction
The Oasys Ltd LS-DYNA Environment 22.1 suite, dated December 2025, is a full release which 
supersedes all previous releases. It is primarily a bug fix release of the Oasys Ltd LS-DYNA 
Environment 22.0 suite.

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 22.0). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required.

1.1 Compatibility with Ansys LS-DYNA® releases
The 22.1 release has been used and tested with Ansys LS-DYNA version R15. It supports all the 
keywords in volumes I, II and III of the released R15.0 User’s Manual (except ISPG). Some of 
the new keywords in the development R16 User’s Manual are also supported. 

Ansys LS-DYNA R11.0 is the default keyword output format of PRIMER. (However, output 
may be generated for later releases.)

1.2 Hardware platforms supported
Oasys Ltd LS-DYNA Environment 22.1 is available on the following platforms:

Windows Windows 11 64 bit

Linux RedHat Enterprise 8.x 64 bit

For Windows, the 22.1 release is built and tested on Windows 11. It should work on Windows 
10, but this is untested. Windows 10’s end-of-life was in October 2025, so you are encouraged to
upgrade to Windows 11 if you currently use Windows 10. The software may also run on 
Windows 8.1, but this is untested. It will not run on Windows versions prior to that because of 
changes in the way Microsoft configure displays.

For Linux, the RedHat Enterprise 8.x build has been released on the website as this has been 
found to run on all the Linux machines we have tested (RHEL 8, SuSE 15.2). If you require a 
different Linux build, please contact Support.

1.3 Graphics hardware supported
The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware.

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort. There are much better ‘thin wire’ graphics solutions 
available today. Please contact Support for more information.
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1.4 Licensing
This latest version of the software uses the LM-X licensing platform to provide an increased 
level of license security. 

To ensure you are ready to enjoy all the great features v22.1 will bring, we recommend you 
update all your Oasys Suite license servers and files as soon as possible. You do not need to 
update if you have already done so for v22.0.

Note that Oasys 22.1 will be the last release for our server licencing package on RHE7, due to its
end of life. 

Action to take 
If you are using a floating network license, you will need to install the LM-X license server 
software (version 5.6.4). The software and supporting documentation are available to download 
from our website and are also included in our installation packages. If you have already done this
for v22.0, you do not need to do it again.

Backwards compatibility 
The Oasys Suite 22.1 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 22.x, 21.x, 20.x, and 
19.x software will continue to work with new LM-X license files and servers.
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2 Bugs Fixed
The enhancements and bug-fixes for each program have been broken down into a series of 
topics. Within each topic enhancements and bug-fixes are listed by case ID.

2.1 PRIMER

2.1.1 Bugs fixed in 22.0

Attached

 Case 56194

The Contact option on find attached was not working correctly. Propagation from selected Part 
to (sliding) Contact is now conditional on this setting.

Batteries

 Case 55734

Battery setup tool: SOCTOU, R0, R10, C10 etc. fields in the ‘4. Randles parameters’ panel can 
now also be set to type *DEFINE_TABLE which was not previously supported.

 Case 55733

Battery setup tool: R10 and C10 buttons in the ‘4. Randles Parameters’ panel were being mapped
in the ‘Randles circuit charge/discharge properties’ section for RDLTYPE=0-order but they 
should not since only R0 is required for this configuration. This has been fixed.

Belts

 Case 55993

The ‘Custom’ option for preset seatbelt mesh density is no longer visible in the dropdown menu. 
Instead, it will only appear in the textbox when a non-default value is chosen.

 Case 55473

PRIMER checks *MAT_SEATBELT to see if any seatbelt elements have a length that is less 
than 1.6 * LMIN. This check included seatbelts ‘inside’ the retractor which, by definition, have 
zero length so it gave false errors. It now ignores these elements.

 Case 54734

For slipring rotations the << arrow button was not functioning as expected. This has been fixed 
and now slipring rotations reset when resetting the fitted belt using the << button.

                    
DOCUMENT3

Page 3



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

 Case 51399

Updated Warning for SECTION EDGESET, a warning will now be issued if the Part ID of any 
EDGESET node does not match the Part ID of the Section card. This warning will only appear if
any of the nodes are not owned by any of the Parts that own the section.

Boundary

 Case 55766

The *BOUNDARY_FLUX keyword was read incorrectly in PRIMER, being treated as an open-
ended keyword terminated at the next *keyword line rather than a finite keyword with #lines 
determined by data field NHISV. 

In most situations when written with a fresh *BOUNDARY_FLUX header for each keyword, 
this would not have mattered, but when multiple definitions followed the initial header, the 
second and subsequent ones would have been omitted. 

Now fixed by applying the correct logic during model read.

Case

 Case 53532

PRIMER tests for attempts to open duplicate editing panels on a given keyword, making the 
second and subsequent sessions ‘browse’ (i.e. read only) to avoid conflicts arising from updating
the keyword from multiple locations. 

This logic did not work correctly for the CASE management panel in some rare situations, this is
now fixed.

Checking

 Case 55692

The check for overlapping contact definitions did not detect the case where the contact was 
defined by part/part-set/shell-set and elements on different sides shared common nodes. These 
are now reported as errors.

 Case 55580

Checking *CONTROL_EXPLICIT_THERMAL_INITIAL no longer causes a crash.

Clipboard

 Case 55626

‘Find referenced items’ on Clipboard will find parameters, but when de-selected, these were still 
copied to the new model or written to the keyword file. If deselected, the *PARAMETER is now
suppressed and latent parameters written to the keyword file.
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 Case 55525

Cleanup unused failed to remove unattached joints if JSTF was defined. Corrected to remove 
JSTF too.

Connections

 Case 56053

Refreshing the connection table when the connections have been externally deleted would result 
in a crash. Now fixed.

 Case 55945

A spurious connection error that the weld node was some enormous distance away from the 
segment (3e32!) was observed when the node was obviously on the segment. This was due to an 
uninitialised variable - now fixed.

 Case 55890

The Simplify option is on for bolts by default. In this mode, PRIMER omits the empty lead rigid 
part. This now also applies for NRB bolts that have converted to C_EXTRA_NODE to attach to 
rigid panels.

 Case 54646

In PRIMER 21.0, the nugget diameter for beam welds was 5mm by default. The nugget diameter
for beam welds now corresponds to TS1.

Contacts

 Case 56323

The contact parameter SLDTHK is now ignored for tied contacts, it was wrongly affecting 
PENCHECK. The default thickness for solids being zero.

 Case 55814

The pick & propagate function in the contact crossed edge fixer has been improved. Previously, 
a crossed edge closed at both ends was required to determine the nodes on the same side as the 
picked node. The process failed when the crossed edge was closed by free edge. This has been 
fixed.

 Case 55254

Resolved the bug where contact surfaces were invisible for the second model in the same 
session.

Contour

 Case 56031

‘Disable discrete contouring’ (on SETTINGS panels)/‘Disable discrete contours’ (on LEVELS 
panel) option: 
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- When contour or vector plots were updated, the availability of this option on opened 
contour & vector plot SETTINGS or LEVELS panels were not updated appropriately. 

- The option will now be disabled/enabled appropriately on any opened SETTINGS or 
LEVELS panels. 

Nodal Mass vector plot SETTINGS panel: 

- The ‘Disable discrete contouring’ option was not working properly. 

- The option can now be correctly checked/unchecked.

Copy

 Case 55475

In the CREATE/MODIFY DEFINE_FUNCTION panel, ‘Copy In’ now successfully copies the 
selected *DEFINE_FUNCTION entity.

Crash Test Setup

 Case 55715

The Batch Crash Test Setup tool will now write all the newly created keywords to the Master 
file.

 Case 53854

The tool now supports barriers that have a *INCLUDE file structure. In past versions, barriers 
had to be a stored in a single master file, but now, barriers with the *INCLUDE keyword are also
supported.

Cut section

 Case 56411

On the cut section custom spacing panel, the position showing 0.0 for the local cut origin is 
disabled. In some cases, another plane position was disabled instead of this. This could happen 
when there are two positions on the panel, where the first was positive and the second is 0.0, i.e. 
when the positions are not sorted after editing, then the number of planes was increased. In this 
situation, negative values are added to the end of the list. After clicking ‘Sort positions’, the first 
position with a negative value was disabled instead of 0.0. 

Additionally, the cut planes did not update on the screen correctly.

Both problems have now been fixed.

 Case 56246

When there was a cut section defined in D3PLOT and the cutting switch was turned on or off 
there, the graphics in a linked PRIMER session did not update as expected. This has been fixed.
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 Case 55561

Cut-section true-thickness capping did not update for thin shells when thickness was updated 
from *SECTION_SHELL. This has now been fixed.

 Case 54177

When a cut plane is close to the plane of the screen, sometimes, the mouse needed to move quite 
far to achieve a relatively small visible change when the plane was dragged. Now, the plane 
origin is moved such that its projection on the screen plane corresponds to the mouse movement. 
This can mean relatively large plane changes normal to the screen, but this seems more intuitive.

When the plane is exactly the plane of the screen, the behaviour is still determined by 
UP/RIGHT for the positive direction and DOWN/LEFT for the negative direction.

Damping

 Case 55266

Data in curve editors invoked from *DAMPING_GLOBAL editors no longer get confused when
reading a curve from a different model when two models in the same session share the same 
curve LCIDs.

Database

 Case 56299

Empty part-set check for *DATABASE_BINARY_D3PLOT was giving a warning for PSETID 
even when it is defined. This has been corrected.

 Case 56178

Corrected typo in *DATABASE_BINARY_RUNRSF field name from ‘NEWRSF’ to ‘NR’ in 
card 1.

Dummies

 Case 56050

The encrypted HBM tree includes can now be written out directly from the Include tree menus.

 Case 55640

The THUMS HBM muscle activation parameters were not getting correctly updated while 
creating the Ansys LS-DYNA ready positioned model in PRIMER. Fixed this.

 Case 55041

For some LSTC dummy models, the H-point was defined with a local coordinate system. 
Previously, the ‘Convert LSTC dummy’ script would not use these values, and the H-point 
would be incorrect in PRIMER. The script now gives the option to use the local coordinate 
system instead for the H-point on a dummy.
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Edit

 Case 56114

The Wordpad editor has been removed from version 24H2 of Windows 11, as of October 2024.

Historically, Text Edit in PRIMER on Windows has used Wordpad if a user-defined editor is not
specified, and if it is not found on the system, it drops back to Notepad. This functionality ceased
to work on Windows 11 systems when the registry entry for that executable was not a simple 
pathname.

This has been fixed, and Notepad now works on Windows 11. 

(If you wish to revert to using Wordpad, you will need to re-install it on your system.)

 Case 55933

If a *SET_xxx_COLLECT definition was edited via Text Edit from an editing panel, this would 
corrupt the set definition when the as-edited file was read back into the model.

In addition, using the global Text Edit tool button to edit *SET cards of any type would not 
work. Nothing would happen.

The first problem was due to the special way *SET_xxx_COLLECT inside PRIMER is split into
child sets, the *SET definitions in the keyword file, and a parent set that exists only inside 
PRIMER. When rereading from the as-edited file, the special actions to resolve the labels of 
these, required to connect child with parent, were omitted, leading to internal confusion.

The second problem was a more general failure to consider how *SET keywords should be 
processed in the context of global Text edit, resulting in the individual sets not being flagged for 
processing.

Both problems are now fixed.

 Case 55536

PRIMER reads *DEFINE_FUNCTION as a string and will therefore not trap tabs on keyin. The 
edit panel, however, does not work well with tabs, so these are now replaced by a single space as
the keyword is loaded.

 Case 54527

The editing panel for *DEFINE_SD_ORIENTATION had field widths that were too narrow for 
the contents, and this keyword had no ‘keyword’ editor. 

Fixed the width problem and also added a keyword editor panel.

Element Quality

 Case 56272

The Jacobian reported in the element quality checks was wrong for the following cases: 

- Tetrahedral solids should have reported 1.0. 

- Thick shell trias reported the wrong value due to being treated as degenerate hexa 
elements. 
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- Cohesive solid penta elements, numbered like thick shell trias, also gave the wrong 
values. 

All corrected now.

Elements

 Case 54661

The Interpolate Thickness option in the Forming tool has been added to interpolate shell 
thicknesses at the nodes from the matched shells in the source model, enhancing the accuracy of 
shell thickness mapping.

Encryption

 Case 55529

*AIRBAG encryption now works with airbags with id but no titles.

Error Trapping

 Case 55607

When a *DEFINE_TRANSFORMATION which uses nodes is used (types POS6N, 
ROTATE3NA, TRANSL2ND), Ansys LS-DYNA requires that these nodes be read before they 
are used. This can cause problems if such a transformation is used to read a 
*INCLUDE_TRANSFORM file and some of the nodes are defined in that file. 

Because of the way it reads *INCLUDE_TRANSFORM (read file, then transform it), PRIMER 
can handle this situation and does not see it as an error. However, Ansys LS-DYNA performs the
transformation earlier, before it has read the file, therefore, it will treat this as an error. 

To deal with this, the error checking in PRIMER has been extended to detect this out of order 
problem and report it as an error during Model Check.

Geometry

 Case 55986

In PRIMER 21.1, after reading CAD data (e.g. via STEP, IGES, etc.), PRIMER’s automatic 
processing of some trim curves could result in some unnecessary unattached 
*GEOMETRY_POINTs. This has now been corrected such that these unnecessary points are 
removed from the model.

 Case 55064

IGES files with nested subfigures did not read correctly. Now fixed.

 Case 51743

Previously, when reading an IGES/STEP file, conic surfaces could be rendered incorrectly. This 
has now been fixed.
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Graphics

 Case 55593

In rare situations, [View] Locate Target and Eye could cause an endless loop and crash 
PRIMER. This could happen if the ‘up’ vector was being calculated automatically and the vector
defined from eye to target was exactly collinear with the existing ‘up’ vector (screen Y axis) 
being used. Changing the current view to anything different before the target and eye operation, 
or choosing an up vector manually, would avoid the problem. 

Now fixed in PRIMER 22.0. This collinearity is detected and an alternative calculation for the up
vector is used instead.

 Case 54804

The PRIMER graphics would sometimes go awry previously if the bounds for a model (or 
multiple models) are quite large (coordinate sizes order of 1E10). This is fixed now.

 Case 53307

PRIMER autoscale was not taking True flat in Shells into account. This has been fixed.

 Case 44056

Once we change the background colour using the popup in Display → Colour, resetting the 
PRIMER preferences did not visually update the graphics background colour. This has now been
fixed.

Help

 Case 55253

Launching the help manual page from the Display Contact Colours panel resulted in a ‘Topic not
found’ error page in the web browser. This has been fixed.

IPP

 Case 55827

Previously, PRIMER could crash when writing out the IPP model with a user-defined impactor. 
This issue has now been fixed.

 Case 55251

When changing to the FMVSS201 option, the default settings would not change. We have now 
added default values for FMVSS201. Now, when changing the regulation, you have the option to
change the default values to match the regulation selected.

 Case 54584

We have made user interface changes for the IPP options to match the regulation. Previously, the
IPP tool would rotate the head when there was any angular difference. Now, if ECE R21 is 
selected, it only rotates if the angle is greater than 5 degrees.
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IGA

 Case 51484

Previously, when reading CAD models into PRIMER (e.g. STEP, IGES), some surfaces may 
have failed to render correctly or not at all. This, in some cases, could have been due to PRIMER
ignoring parametric trim curves for rendering purposes. This has now been fixed such that 
PRIMER makes use of parametric trim curves when rendering CAD surfaces.

Include Transform

 Case 54643

PRIMER would skip *INCLUDE_TRANSFORM definitions when reading a model if the 
transformation data was missing (i.e. there was only a filename). Now, PRIMER also gives an 
error message when this happens.

Integration

 Case 55915

PRIMER did not recognise ‘.d3plot’ files in the directory when the D3PLOT link button was 
clicked, displaying the ‘Find Results’ button instead of ‘Start D3PLOT’. This is now fixed.

 Case 54043

In previous versions, dynamic rotations performed in D3PLOT could cause the corresponding 
view in a linked PRIMER session to flicker in scenarios involving multiple D3PLOT models 
loaded into the same window(s). This issue has now been fixed.

JavaScript API

 Case 56390

Some links in the JavaScript API PDF manual were re-directing to a different program when 
different functions with the same name were present in more than one program (e.g. the 
PRIMER Node class BlankAll function was re-directing to the D3PLOT Node class BlankAll 
function). Issue now fixed.

 Case 56132

Previously for some monitors running with a particular resolution windows mapped from 
Window.Message, Window.Question etc. could come up too small with scrollbars. This is now 
fixed.

 Case 56077

Previously, if an error occurred in a JavaScript while processing the onClick function of a 
Widget in a PopupWindow, the error would not be handled correctly and PRIMER would not 
process button clicks in the JavaScript Window, including the Dismiss button. This has now 
been fixed.
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 Case 55932

Support for custom JavaScript checks has been added to the HexSpotweldAssembly JavaScript 
API class.

 Case 55900

The JavaScript debugger could crash if you right clicked in the empty bottom left breakpoints 
section. This has been fixed.

 Case 55897

The GetComments method for parts, nodes etc. would crash PRIMER if the entity did not have 
any comments. This has been fixed.

 Case 55742

The thickness property (thick) for InterpolationSpotweld was not working in the JavaScript and 
Python APIs. This has been fixed.

 Case 55376

The JavaScript related exception thrown by PRIMER was returning the wrong function names 
for where the exception occurred. This has been fixed.

 Case 55272

The radio button widget in the GUI Builder no longer allows you to set the text property (which 
was not used anyway). Issue fixed.

 Case 55067

Giving an invalid input while setting a property, does not reset other properties in that class now.
Issue fixed.

 Case 54931

Resolved the issue where variables returning null during debugging of the JavaScript API script 
were incorrectly displayed as ‘! invalid !’ in Quick Watch.

 Case 54629

The order of the logic for finding scripts/modules has been changed to allow user-specified 
locations to override install locations. Issue fixed. Please refer to the PRIMER manual for 
details.

 Case 54249

The find attached tool has been revised so options work more consistently. For example, if the 
beam entity switch is off, beams will not appear even if ‘Tied contacts’ is on and the beams are 
tied. Issue fixed.

 Case 53690

Previously, when running a child script with a shared runtime with its parent script, PRIMER 
could potentially crash if the parent script was closed before the child script finished. This has 
now been fixed.
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 Case 51231

The Model ImportInclude method did not work correctly when importing include file 0 (the 
master include file) from another model. This has been fixed.

 Case 48968

When adding segment sets to a *SET_SEGMENT_ADD card using API ADD(), an exception 
that only applied to the *SET_SEGMENT case was thrown. This is now fixed.

Keyword

 Case 56506

PRIMER crashed when running a check while creating an empty 
*ALE_AMBIENT_HYDROSTATIC. This has been fixed.

 Case 56288

When PARM3 had been defined as CID for discrete beam, PRIMER did not allow the input of 
zero. The previous value re-appeared on update. Zero is now permitted. Issue fixed.

 Case 55590

Absolute/Relative Include file path options were disabled for the *INCLUDE_STAMPED 
keyword. Fixed this.

 Case 55576

PRIMER could incorrectly assign label zero to 
*INCLUDE_STAMPED_PART_SOLID_TO_SOLID in the keyword editor. Fixed this.

 Case 55540

PRIMER used to write out the header only once for the *DEFINE_FILTER keyword definition, 
which causes an error in the Ansys LS-DYNA run. This has now been fixed to write out the 
header for every *DEFINE_FILTER keyword definition.

 Case 55375

PRIMER wrote out the *ICFD_BOUNDARY_FSI_EXCLUDE keyword for versions earlier 
than R11. However, the correct versions to write out are R12 and above. This has been corrected.

 Case 55372

Fixed a bug in the reading and editing of *EM_RANDLES_MESHLESS where the float fields 
TEMP and TAU were being rounded, not allowing any decimals.

 Case 54777

Initially, when writing out a key file including multiple *MESH_SIZE_SHAPE cards, PRIMER 
wrote all cards under one keyword header *MESH_SIZE_SHAPE. Now the header 
*MESH_SIZE_SHAPE is written out for each card.
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 Case 54260

Fixed the bug where changing METHOD to 1 in *MESH_SIZE_SHAPE did not update card 2 
properly sometimes.

 Case 54120

Fixed the bug where model modified showed differences in 
*DAMPING_FREQUENCY_RANGE even though there are none. This happened when we 
created a card with option 1, gave a non-zero value for the PIDREF field, changed the option to 
DEFORM, then write out the model. Now, model modified between the original and the written-
out file/model will no longer give a difference when there are none.

 Case 53148

When the Ansys LS-DYNA R14 *CONSTRAINED_RIGID_BODY_SET keyword is written 
out for older versions of Ansys LS-DYNA, the definition is now written as multiple 
*CONSTRAINED_RIGID_BODYs instead. Issue fixed.

Keyword Editor

 Case 53902

Fixed a bug in the *EM_ISOPOTENTIAL keyword where the field ‘SETID’ only accepted the 
IDs of *SET_NODEs. Now, it can take the IDs of *SET_SEGMENT or *SET_NODE or 
*MESH_PART based on the value of the field ‘SETTYPE’. Issue fixed.

Load Paths

 Case 55542

Fixed a bug that was causing PRIMER to read in white space following a *LOAD_PATH card 
as an extra NULL *DATABASE_CROSS_SECTION instance added to the list in the load path 
definition during keyin.

MPP

 Case 55022

Decomposition ‘Show Assembly’ was not working if SET PART TREE is selected. When 
clicking ‘Show Assembly’ in the decomposition panel when the option SET PART TREE was 
selected in the Part tree popup, the Part Tree panel with the Assembly option will now be 
mapped as expected.

Macro

 Case 55925

Fixed missing and erroneous macro command tags for SOLVER and ITS popup buttons 
respectively in the Create/Edit panels for *SET keywords.
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Manual

 Case 55650

Corrected the example of DialogueInput: DialogueInput(‘/re dk model_1.key 1’, ‘/re dk 
model_2.key 2’) under the Global class in the PRIMER JavaScript API Manual to 
DialogueInput(‘/rea dk model_1.key 1’, ‘/rea dk model_2.key 2’) since the READ command 
requires at least three characters for abbreviation. The first two letters (/re) overlap with the 
RENUMBER command.

 Case 54820

Web links pointing to ‘Assemblies’, ‘Points’, ‘Stretch’ and ‘Applying motion to Database Cross 
Sections’ of the ‘Tools’ → ‘DUMMIES: Positioning Occupants’ → ‘Creating and Editing 
Dummies’ page in the PRIMER Manual have been changed since they were initially not pointing
to the right webpages.

Mass

 Case 55546

When a model contained masses in include A attached to elements of include B, the mass 
property calculation by include (either by the massprop tool or by JavaScript) gave unreliable 
results when run in threaded mode. With threading switched off, it worked correctly. This is now
fixed.

Materials

 Case 56179

For *MAT_275, corrected the typo of field name from ‘B’ to ‘K’ in card 1.

 Case 55895

The material section listing function was found to crash when a title contained ‘%’. This 
character is now supported.

Measure

 Case 53904

When clicking the ‘Unit Vector’ check button in the Node-to-Node measure panel, it will now 
refresh and update the content of the panel accordingly.

Mechanism

 Case 53745

In mechanisms with a coupler between one translation and one rotation, the positioning could be 
very slow when one of the connections is moved. In these cases, scaling the model length units 
may have changed the drag sensitivity. For mechanisms with one such coupler, the dragging 
behaviour has now been improved and is now independent of the length units.
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Memory

 Case 53599

Contact penetration checking in PRIMER is parallelised for speed, but one consequence of this 
was a tendency for memory consumption to increase each time a penetration check was 
performed because memory was not recycled efficiently across multiple parallel threads. 

The logic used to allocate, recover and redistribute memory has been rewritten to improve the 
efficiency with which it is used in parallel coding. There may be a small memory increase when 
a penetration check is performed the first few times, but this should now settle down so that 
repeated checks of the same contact should not continue to consume further memory.

Menus

 Case 55971

Added simple condition to the HIC tool to test whether a file exists and prompt you to confirm 
it’s ok to overwrite when it does.

 Case 55223

On Windows, any PRIMER child windows that are dragged out onto the desktop appear as mini 
preview windows when you hover over the [Pr] icon on the Windows taskbar. Each preview has 
an ‘X’ which if clicked on will close the window in question. 

This went wrong in two ways: 

(1) ‘Always there’ windows such as the Part Tree in PRIMER disappeared and could not be 
re-instated, the dialogue box and graphics windows suffered the same fate. 

(2) In some cases, the fact that the window was no longer there could cause a crash when 
PRIMER tried to use it because it did not ‘know’ that the window had been deleted. 

These are now fixed. ‘Always there’ windows will now be removed from the desktop by 
remapping them inside the PRIMER master window, so they are moved rather than deleted. 
Windows which can be deleted legitimately, for example an editing panel, are now deleted in a 
way which PRIMER ‘knows about’ so there are no internal inconsistencies.

Mesh

 Case 55605

The logic in the algorithm to add a hole to a mesh has been improved to fix an issue where 
PRIMER could occasionally crash.

 Case 54003

The Ruled Mesh panel now allows for discrete and continuous line selection options:

- The discrete selection allows you to pick nodes in discrete lines between two nodes and 
automatically starts a new line to pick nodes from after each second node. 

- The continuous selection allows you to pick nodes in a continuous line without 
separation.
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These were not working properly previously and are now fixed.

Model Build

 Case 56312

Some spurious error messages about missing files when scrolling the model build template have 
been removed.

 Case 56309

When a model has been built from a PRIMER database, there should be a ‘link>database’ button
on the master drop-down on the include tree. This button was obscured by ‘Re-order includes’ 
button added later. Issue now fixed.

 Case 56206

When nomenclatures were changed in model build coding to remove terms master/slave, the 
template save with orient points was broken and the help text also became very confused. This is
now fixed.

Model Modified

 Case 55520

A model containing tabs can now be read using (at your own risk) ASSUME_6/8 option. It could
not be read properly previously and is now fixed.

Additionally, there is a new option PERSIST_6/8 which can be used so subsequent internal read 
operations (such as model modified - compare to original) will work.

Morphing

 Case 56203

Previously, when using selection mode in the Morphing tool to make an initial selection of a 
drag handle associated with multiple morph points, all but one of these morph points would be 
highlighted in the background colour as opposed to the sketch colour. This has now been fixed 
such that all points are highlighted in the sketch colour. 

In addition, when making a fresh selection of morph points after a previous selection of morph 
points that has since been reset, if the number of points selected matched the number of 
previously selected morph points, PRIMER would not issue a message to the dialogue box 
stating the number of morph points currently selected. This has been fixed such that PRIMER 
now issues this message in this event.

Nastran

 Case 54647

PRIMER crashed while it was trying to read a NASTRAN file with missing include file(s). This 
has been fixed now.
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Orient

 Case 55976

Implementing read model 1, read model 2, delete model 1 followed by use of orient interpolation
could result in a crash previously. This has been fixed.

 Case 53871

Orient of include with child include(s) will now, by default, orient child include(s) even if it is 
not selected. Issue fixed. This behaviour is particularly useful for command line contact orient 
which only allows you to specify one include. This may be configured by the preference 
‘orient_child_include_with_parent’.

Parameter

 Case 54722

There were a range of errors in the handling of _MUTABLE parameters in conjunction with 
*INCLUDE files generally and *INCLUDE_TRANSFORM in particular. 

For the general *INCLUDE case, the parent file did not necessarily ‘know’ that an include file 
referenced a mutable parameter, and therefore, did not precede the *INCLUDE statement with 
that parameter. 

In the more specific case of *INCLUDE_TRANSFORM using a mutable parameter defined in 
the parent file, this could get ‘lost’ altogether when processing the include, and repeated use of 
the same include file (transformed into different positions) using versions of mutable parameters 
with different values for each include instance could end up using the wrong version of the 
parameter. 

The processing of mutable parameters generally, and their usage with *INCLUDE files 
generally, has been greatly improved.

Part Tree

 Case 53547

When we have a tree with several parts (10 is enough to see it), if we select all of them and drag, 
the whole tree refreshes constantly, producing a flickering graphics issue. This has been fixed 
now.

Pedestrian

 Case 55838

The HIC tool could produce a JavaScript error ‘Window.EndLoop called without previous 
Window.StartLoop’. This issue has now been fixed.

 Case 54932

Previously, for GTR/UN R127 and GB 24550 protocols in the Pedestrian Markup Tool, in 
PRIMER selection of bumper beam parts was not supported. This has now been corrected.
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 Case 53602

The ‘Cancel’ button in the Define windows of the pedestrian markup tool was not working as 
expected as pressing it would not revert the changes. Therefore, it has been removed. 
Additionally, the ‘Apply’ button has been replaced with a ‘Close’ button. The textboxes update 
as you are adding data, therefore, there is no need to press ‘Apply’ or close the window. Issue 
fixed.

Program Crash

 Case 55432

With ‘CleanUp Model’ panels opened, after panels were launched via PRIMER macros or 
JavaScript, PRIMER crashed when the ‘CleanUp Model’ panels are resized. Fixed this.

Python API

 Case 54284

PRIMER did not terminate if the gRPC connection could not be established in the 
Oasys.PRIMER.start command. Now fixed.

 Case 53896

The GetAll and GetFlagged methods for Oasys.PRIMER.Node, Oasys.PRIMER.Shell etc. would
fail if there were more than ~300,000 objects in the list. This has now been fixed.

Read

 Case 55911

When a parent file contained a material, section, or part definition with a character label and 
referenced an *INCLUDE_TRANSFORM file which contained something referring to the 
material, section or part, PRIMER could report wrongly that a duplicate definition label clash 
had occurred. This was because the *INCLUDE_TRANSFORM file treated the reference to the 
item as a definition of the item in the label clash check. Now fixed.

 Case 54112

IGES files containing B-REP entities are now supported. Issue fixed.

Scripting

 Case 56480

If the module contained an error, PRIMER would not throw an exception when importing a 
module using dynamic module import. Now fixed.

 Case 55957

On higher resolution monitors (4k), the images in the ‘Sled Test’ script were scaled down. It is 
fixed now.
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 Case 55521

In the Attached class of the JavaScript and Python APIs, links have been added to the Attached 
function of the Model class. Confusing API issue fixed.

 Case 53825

Resizing the graphics window caused UI problems with the JavaScript Running window. We see
an unnecessary vertical slider, and if we scrolled down, we even see elements from the 
JavaScript tree. This has been fixed to make sure we are not in ‘Running’ mode before showing 
the script tree.

Segments

 Case 53671

Changes in PRIMER 21 to fix speed issues related to segments on *BOUNDARY, *INITIAL 
and *LOAD cards exposed two problems: 

- The changes meant that it was no longer possible to convert these cards easily into their 
segment set variants (rare, but possible).

- Long-standing problems with graphics might mean that some of these cards were not 
drawn (only sketched), might not be screen-pickable even if visible, and the feedback 
given during screen-picking was not helpful. 

These problems have now been fixed.

Sketch

 Case 56052

Clicking on ‘Sketch all’ more than once on the docked Contact panel or clicking ‘Sketch all’ 
then ‘Apply’ and vice versa makes the sketch disappear. This is fixed now.

Text

 Case 55949

Unusual node formatting in orient text boxes now fixed: changed lowercase m1n1 or m?n? to 
uppercase M1/N1 or M?/N? in the orient panels.

Thermal

 Case 55435

A zero MID field on part card edit/keyword panel is no longer highlighted in red if the analysis 
is purely thermal. The previous incorrect red highlight has been removed.
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Transform

 Case 55938

PRIMER did not implement the correct behaviour for *DEFINE_TRANSFORMATION option 
TRANSL2ND with a3=0 (defined in R14 and above). Now fixed. 

If required, the behaviour can be changed back to the old R12 and R13 behaviour using the 
preference primer*define_transformation_transl2nd_a3_zero

 Case 55882

Labels in *DEFINE_CURVE_FUNCTION expressions would not get updated correctly by 
PRIMER in some cases when the expression wrapped over multiple lines. Now fixed.

Unicode

 Case 54744

‘ANSI’ encoded include file comments should now be handled correctly by PRIMER. Issue 
fixed.

User Interface

 Case 56240

In Part Tree → Find, the up/down buttons (in Find and List) did not have modern icons. This is 
now fixed.

 Case 56214

Changed the Dummy Angles File retrieve tab, so that ‘Move H-Point’ shows in the tick-box 
design, rather than the toggle box design. Issue fixed.

 Case 56200

Fixed the width of Tools → Check Custom Preference File directory button so that the icon is no
longer cut off.

 Case 56116

Fixed inconsistent panel colours in the Dark theme when running the HPM and HRMD tools.

 Case 56075

In the Model Build summary box, check box, and contact check box, there were some minor UI 
issues. Mainly wrong colour of background in some areas of the panels. Now fixed.

 Case 55982

Selected tab in the cross references panel would have a hover effect implying it could be 
deselected. This has now been fixed, only unselected tabs which can be clicked will have a hover
effect. Panel headers have also been modified to be more consistent.
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 Case 55959

After using select files to write a file, the filename is now correctly highlighted with red to 
indicate the file exists.

 Case 55172

Some buttons in Normals/Align, Remesh area, and Morph panels were not associated indicating 
that they are mutually exclusive. This has been fixed.

Volume III

 Case 54188

*EM_BOUNDARY_PRESCRIBED can now refer to a function via a negative ID in the field 
LCID in PRIMER.

 Case 53868

Previously, <MID> in *EM_MAT was a unique label and did not refer to the *MAT keyword, 
causing the label to be lost during renumbering. 

It is fixed now. The <MID> field now references *MAT cards.

Write

 Case 56242

PRIMER will now print a message after successfully writing out an assembly file.

 Case 56128

Previous versions of PRIMER did not support the *TITLE card on a per-include basis. This had 
a couple of implications: 

(1) *TITLE cards would never be written out to include files (only ever to the master model) 
even if input includes were to contain those cards. 

(2) *TITLE definitions were previously parsed during model read on a last-one-wins basis. 
Consequently, the last *TITLE card read in (whether it be from the input master or from 
an include) would become the master model’s *TITLE - the de-facto analysis title in 
effect. 

These issues have now been fixed. *TITLE is now supported on a per-include basis. The master 
model and each include can carry their own respective *TITLE definitions.

 Case 55135

Fixed user interface inconsistencies and autoscaling in the Write Include panel.

 Case 54205

Write select files from the PRIMER tree will create directories in the expectation that files will 
be written. If no file is written, previously, the unwanted directory was not removed. This is now 
fixed: the unwanted directory will now be removed. 
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Additionally, if a file cannot be written due to read only file permission, the background will be 
orange-lit (as it will be for a directory without write permission).

Xref

 Case 54996

Previously, in the very unlikely case of a morph point being used in a morph flow definition 
multiple times, removing the point once would corrupt the cross references from the morph point
to the morph flow. This has been fixed.

2.1.2 Bugs fixed in 22.1

Blanking

 Case 56315

Cohesive solid elements and parts were unexpectedly blanked when using quick pick blanking 
when they have not been selected. Now fixed.

Checking

 Case 57755

A *CONSTRAINED_EXTRA_NODE on a rigid part is an error even if the node is on a part 
merged to PID of the constraint or on an element of that PID. PRIMER now reports these 
instances with an error.

 Case 57079

When writing xml check files, some DATABASE items did not have a formal name which is 
valid xml. Consequently, the xml file would not read back into the check tool as a reference 
check file. This was fixed by using valid names in this context but leaving the formal name 
unchanged for other contexts.

 Case 56791

PRIMER did not report an error when TIME1 was equal to TIME0 in 
*LOAD_REMOVE_PART. Fixed.

 Case 56612

Dependent nodes of *CONSTRAINED_ INTERPOLATE on seatbelt elements were incorrectly 
reported as an error. The check has been corrected.

 Case 56129

A section card with no thickness defined is valid if all the shells that reference that section have 
nodal thickness defined by other means (typically *ELEMENT_SHELL_THICKNESS). In this 
case, PRIMER no longer reports a section error.
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Clipboard

 Case 56839

Use of ‘sub-model from visible’ involved a rather extreme cleanup operation on models with tied
contact on large node sets. This could result in calling repeated contact checks on tied contact 
where the master surface is empty. This has been fixed by updating the status flag on empty 
contacts that have been checked.

Coating

 Case 55964

In the coat tool, for the face selection and propagation option, when a higher break angle is 
selected the face selection propagates according to the break angle. Then when the break angle is
reduced and ‘Sketch new shells/segments’ pressed, the selection did not update to the new break 
angle. Rather the previous selection for the higher break angle was maintained.
This is now fixed, and the face selection updates whenever ‘Sketch new shells/segments’ is 
pressed.

Command Files

 Case 57287

PRIMER would previously exit prematurely if you were to invoke -batch or -exit options while 
running a command file loading a script which in turn would run a macro. This issue has now 
been fixed.

Compare

 Case 56776

The Excel file generated from the PART COMPARE table had mismatched headers and spacing 
issues for the second model. Now fixed.

Connections

 Case 57828

The searchable Select bolt module drop-down box on the create bolt menu is now correctly 
dismissed when menus are closed using the keyboard shortcut.

 Case 57861

When making an adhesive connection by screen picking on a TSHELL surface, PRIMER was 
crashing. Now fixed.

 Case 57565

On the connection create panel ‘sketch adhesive’ option was not working for patch adhesive. 
Now fixed.
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 Case 57430

Removing segments when creating adhesive patches (connections) on solid surfaces did not 
work. Now fixed.

 Case 57224

The ‘Reset All’ button on the ‘Connection creation options’ panel did not work for the 
‘Automatically remove missing layer(s) on remake’ option. Now fixed.

 Case 56956

Remaking connections on the table on models with many arc-weld connections each with their 
own contact could result in a crash. This has been fixed.

Constraints

 Case 56718

The NRB create/modify panel has been extended so scroll bars do not appear for the IGA option.
Also ‘Move node to centre’ is disabled when the node is referred to by IGA_POINT_UVW as 
the point needs to be on an IGA surface.

Contacts

 Case 57294

When converting the model unit system from one type to another, PRIMER incorrectly 
multiplied the penalty scale factor (SFS) by a factor. PRIMER now applies unit change for SFS 
cards on contact only if a curve is used.

 Case 56742

The tied/untied node count displayed on the check tree was based on the stand-alone check of 
tied contacts. The count has been modified to include the possible conflict of constrained contact
segments which may occur if IPBACK is not in use. If IPBACK is set, these conflicts are 
ignored as the penalty contact is operative.

Contour

 Case 56670

Fixed the problem of some solid element faces disappearing while contouring and requiring a 
further press of CT or SI.

Crash Test Setup

 Case 56793

The ‘Save Crash Test’ panel was not very clear when saving or replacing a test. PRIMER has 
improved messaging and logic now to clarify where the test is saved and when ‘Replace’ is 
applicable.
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Curves

 Case 57608

Fixed an issue where curve titles disappeared in Compare view when switching between curves 
with different numbers of data points.

 Case 55354

Fixed a bug causing PRIMER and T/HIS to have inconsistent data values when sending curves 
without including the scale factor and offset.

Cut Section

 Case 57453

When in a linked D3PLOT session and a cut section is turned on by picking a node, sometimes 
the equivalent cut plane in PRIMER was not drawn until some other cut section options (for 
example positive or negative actions) were changed. This has now been fixed.

Database

 Case 57047

When running database/template build from the command line, the default of highest available 
version was always applied irrespective of the DEFAULT_VERSION setting in the .dba file. 
This has been corrected. Additionally, a new command line VERSION command has been added
which, if used, will over-ride any default version.

Deleting

 Case 56949

If an *AIRBAG_SHELL_REFERENCE_GEOMETRY card was deleted when PRIMER had 
swapped the display of the shell and airbag reference geometry topologies, the topology would 
get corrupted. Now fixed.

Dummies

 Case 57526

PRIMER now allows selection of SHELL part nodes with BONE material, to attach positioning 
cables on HBM assemblies.

 Case 57255

For multi-stage positioning with Dummies/HBMs, the conditions for displacement of positioning
cable elements were insufficient during intermediate stages of positioning analysis. 
Displacement curves have been modified to fix this.

 Case 57085

Fixed a possible crash in Dummy/HBM positioning while creating and moving a new *POINT.
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 Case 56986

The check for seatbelt elements not being less than LMIN on *MAT_SEATBELT was 
programmed wrongly. The check should have been all seatbelt elements must be > LMIN and 
seatbelt elements on sliprings or retractors must be > 1.6 * LMIN

However, the test wrongly treated any seatbelt element, even those not on a slipring or retractor, 
being less than 1.6 * LMIN as being in error. This has been corrected.

 Case 56768

In multi-dummy positioning, duration and settling time were not updating correctly while 
changing units. Additionally, Youngs modulus and Density values for lead rigid body were not 
getting updated with change in units. Both these issues are fixed.

 Case 56672

Incorrect units were used for material properties for lead rigid body created by PRIMER during 
Dummy positioning. This is fixed.

 Case 56504

In dummy positioning, you will now be warned when you attempt to set an assembly rotation 
value to zero.

Edit

 Case 57330

When dragging rigid-walls on the screen, the menu could flicker. This has been fixed.

 Case 56615

The Create button on the Create/ Modify editor was not always greyed/ungreyed correctly for the
*CONSTRAINED_EXTRA_NODES and *CONSTRAINED_RIGID_BODIES keywords. Issue
is now fixed.

Elements

 Case 56861

Warning messages when the same part ID is used multiply in *ELEMENT_MASS_PART have 
been improved.

 Case 56318

The Aligning tool now works for cohesive solids which are pentas with elform = 19.

FMH

 Case 56395

FMH script was crashing when using impactor files with nested includes. This has now been 
fixed

                    
DOCUMENT3

Page 27



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

Formatting

 Case 56314

*DEFINE_CONSTRUCTION_STAGES was not storing the title correctly. Now fixed.

General

 Case 57523

Add new child could fail if a *SET_PART_COLLECT in the child model clashed with plain 
*SET_PART of same label in main model. De-clash is now only disabled if both sets are 
_COLLECT and can merge. Additionally, following the failure of add new child, subsequent 
attempts to read in another model caused a crash. Both fixed.

Geometry

 Case 57549

Fixed some issues causing some surfaces to fail to render when reading a CAD file:

- If a surface had both real-space and parametric-space trim curves, but these curves were 
in opposite directions to each other, PRIMER would not align their orientations which 
could lead to that surface failing to render. This has now been fixed such that PRIMER 
does align their orientations.

- If a surface wrapped around on itself, such as a cylinder, and had one or more holes 
trimmed the surface would fail to render. This has now been fixed.

- If a surface was very thin in one direction but very long in the other, it was possible that 
rendering of this surface would take a very long time. If running PRIMER with multiple 
threads this surface would likely fail to render. This has now been fixed.

 Case 56152

Previously, PRIMER would render CAD surfaces, defined as offset surfaces, in their non-offset 
position. As a result, these surfaces were not rendered in their correct positions. This has now 
been fixed.

Graphics

 Case 57599

When the size of the graphics window in PRIMER exceeded 4096 pixels in any direction, 
possible when a desktop spans multiple high resolution (4k or above) monitors, the code could 
crash.

This was due to a limit of 4096 pixels imposed by legacy 2d graphics support. Now fixed.

 Case 56862

On some hardware there could sometimes be a ‘black flash’ of the graphics window following 
some screen blanking or dynamic viewing operations. This would be more likely on laptops and 
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on monitors connected via the USB port. This was due to unnecessary window stacking order 
operations which only had an effect on some hardware. Removing those operations fixes it.

IPP

 Case 56979

The slider was slightly mis-aligned for IPP KEYOUT panel. It has been fixed now.

Integration

 Case 44547

PRIMER was not launching an integrated T/HIS session from *DEFINE_CURVE_FUNCTION 
after a previous integrated T/HIS session had been exited. Now fixed.

JavaScript API

 Case 57729

The constants Conx.SPOTWELD_SOLID1, Conx.SPOTWELD_SOLID4 etc were removed in 
PRIMER 22.0. They have been reinstated as deprecated constants in PRIMER 22.1.

 Case 57593

Encrypting a script could create a script that would not run if the script contained ‘Use’ and used 
classes. Now fixed.

 Case 56697

Drawing a polygon with Graphics.PolygonStart() could cause errors in PRIMER. Now fixed.

 Case 55934

When a JavaScript which uses Model.MergeNodes() was run in batch mode, a spurious error 
message was displayed in the terminal. Now removed.

 Case 55549

API function ImportInclude (model class) was not behaving correctly if a master model was 
being imported as an include into an existing include of another model. This occurs where the 
argument ‘source’ is a master file (not an include file), and the optional argument ‘target’ was 
being used. The import has been fixed.

Keyword

 Case 57179

Missing ERODE options on *CONTROL_TIMESTEP have been added.

 Case 57118

Previously for *ELEMENT_SOLID_PERI, fields <n1>, <n2>, <n3> <n4> were not working 
properly in the generic editor. Now fixed.

                    
DOCUMENT3

Page 29



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

 Case 56901

The material keyword editor got confused with the input data for 
*MAT_ARUP_ADHESIVE/MAT_169 keyword as there are field dependent optional cards. 
Now PRIMER shows field headers and its respective data correctly in the keyword editor.

 Case 56625

PRIMER was crashing during read in for various *EM_EP keywords which were added in 
PRIMER 21.0. This has been fixed.

 Case 56407

For create panel of *ALE_FSI_TO_LOAD_NODE keyword, the PATH field has been added. 
For create panel of *FATIGUE keyword the FILENAME field has been added.

 Case 55741

The *SECTION_BEAM keyword editor was not always updating rows correctly when changing 
ELFORM. Fixed.

Load paths

 Case 57247

The load path tool was being allocated a new flagging bit whenever a new instance of its editor 
panel is opened, which could cause PRIMER to run out of flagging bits. Fixed.

 Case 57135

The ‘mdumm_keyout_format’ preference has been renamed to more descriptive 
‘post_end_keyout_format’. It can now be used to write the post *END data in formats of older 
PRIMER versions for the Dummies, Mechanism, Belt fitting and Load path tools.

Manual

 Case 57842

Fixed an issue where the local Workflows manual was missing on Linux.

Mass

 Case 57040

Assign mass that contains *PART_INERTIA and *ELEMENT_MASS_PART could initialize 
on the create assign mass panel displaying incorrect mass (omitting the *PART_INERTIA). If 
the panel is refreshed e.g. by clicking on the node/part radio button, the correct mass value would
appear. The panel updates correctly now.

 Case 56679

If you tried to delete a *PART_SET or *ASSEMBLY used by Assign Mass while the 
Create/Modify Assign Mass panel window was open, PRIMER would crash. This has been 
fixed.
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Materials

 Case 56760

In the material keyword editor, there were some fields in which the acronym header could be 
blank, an example being AOPT on some materials with optional local axes. The data could still 
be entered, and the data field would be processed correctly, but the absence of an acronym meant
that writing the material to a CSV file did not work correctly.

The error occurred because these fields were ‘value if +ve, item label if -ve’ and the internal 
logic which populates the field header was treating the ‘number’ case wrongly.
Now these fields will now have a detailed definition of what can be in the data field.

 Case 56142

The incorrect omission on key-out of cards 4-6 for *MAT_68 (when all fields are blank) has 
been fixed. These cards are mandatory as the Ansys LS-DYNA submission fails without them.

In PRIMER 21.0, a preference ‘mat_68_write_all_cards’ was added to allow the keyword to be 
read by older versions of PRIMER. This gives the option to write out all cards if set (even if all 
fields are blank), and exclude cards 4-6.

This option has been removed. The three cards now always get written regardless of the selected 
Ansys LS-DYNA version. PRIMER will be able to read in both configurations (with cards 4-6 
included or excluded).

Measure

 Case 56939

Unattached nodes could previously, under rare circumstances, not be pickable even when 
drawing (or labelling) of unattached nodes was activated. This issue has now been fixed.

 Case 56704

Node to node distance was not displayed on screen when free edge node curve option was 
selected. Fixed.

Mechanism

 Case 57473

Simultaneously loading multiple instances of the Mechanism and/or 
*INTERFACE_DE_HBOND create/modify panels was making PRIMER increasingly slow and 
eventually led to a crash. Now fixed.

Merge

 Case 56965

Merging two identical copies of a model containing *ALE_STRUCTURED_MULTI-
MATERIAL_GROUP caused a crash. This was because the _STRUCTURED variant of ALE 
multi-material groups provides an alternative to the plain multi-material group card using names 
to define them. As consequence, these cards need special logic inside PRIMER which had not 
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been added to the merge process. This caused a merge failure when identical names in the two 
models clashed. This has now been fixed. Model merge will now increment these names just as 
it would for labels or other named cards (e.g. PARTs).

Mesh

 Case 57343

PART labels in the Mesh panels were not correctly handled during UNDO operations. Fixed 
this.

 Case 57052

Fixed a crash that occurred when using the 3x3 shell split tool.

 Case 56631

Fixed a bug in Mesh → Extrude → Solids where selected faces were not being sketched (as they 
are for shells).

Orient

 Case 57100

Orient + Copy on a model containing ANSA comments, free-standing PGP data blocks and some
other abstruse contents could lead to these being duplicated after each Orient + Copy operation. 
In the worst case of multiple operations this led to a geometric progression and ultimately 
running out of memory, but even a single such operation could result in unwanted duplication of 
these ‘extra’ contents of files. This has now been corrected. In the Orient + Copy case only those
items selected for orientation are now duplicated with extra items being left unchanged.

 Case 56335

Previously, cancelling the Orient Translation (Drag) operation corrupted the centre of gravity 
data in *PART_INERTIA cards. This issue has been fixed.

Output

 Case 56784

Since PRIMER 21.0, nodal coordinates have been stored in double precision 64-bit floats.

PRIMER has legacy keyword output precision options for 32-bit floating point values which 
historically would have been applied to *NODE cards, but which no longer affect them. There 
are new 64-bit precision output options which will control nodal coordinate output, but it was not
very obvious that the old 32-bit options no longer affect nodal output.

So added a warning that is triggered whenever one of the legacy 32-bit output options is 
changed. This explains that *NODE coordinate output will not be affected and explains how to 
control this if desired.
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Part Replace

 Case 56852

Assembly Replace failed to work on a complex model with many *SENSORs in the assembly to 
be replaced. The logic for deleting sensors has been improved.

Part Tree

 Case 56705

A ‘Latent entities’ button has been added under ‘Opts’ in Part Tree. When enabled, latent entities
are shown in Contents and List modes, with ‘(Latent)’ appended. Preference 
‘part_tree_show_latent_entities’ supports this option.

 Case 56285

Upon selecting items on the Part Tree → Contents → List panel, the headers on the docked panel
were greyed out incorrectly. Also, when undocked, the ‘PART TREE CONTENTS LIST’ panel 
was blocking the docked ‘Part Tree’ panel. Both fixed.

Pedestrian

 Case 56465

Previously, the Pedestrian Markup tool would use an infinitely long stick to determine the upper 
bumper reference line when bumper parts were provided, regardless of the protocol selected. 
However, this was incorrect for the CNCAP, UN R127, and GB4550 protocols, whose 
documentation specify a 700mm stick regardless of whether the bumper is identified. This has 
now been corrected to match the protocol documentation.

In addition, when using a finite stick length, the tool would potentially find an incorrect ‘first 
contact point’ with the bumper, specifically in the case that the tip of the stick should make first 
contact with the bumper. This has now been fixed.

 Case 56414

Previously, for some vehicle geometries, the Pedestrian Markup tool could find the incorrect 
intersection between bonnet leading edge and side reference offset lines, leading to the 
generation of some impact points outside of the expected testing zone. This has now been fixed.

 Case 56266

Previously, PRIMER’s pedestrian model build tool would only write an ANGLE field to the 
output .lst file when performing a PEDHEAD_ANGLE type build. This would then cause issues 
when running the GTR/UNR 127 (2022) Pedestrian Head Impact template in REPORTER with 
that .lst file. The pedestrian model build tool has now been updated to always write out the 
ANGLE field, regardless of what type of pedestrian model build is being performed so as to 
remain compatible with the pedestrian REPORTER template(s).
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Preferences

 Case 57039

Preference ‘primer*hbm_use_encrypted_mats_for_cables’ is now implemented properly.

Program crash

 Case 57481

When PRIMER is running in command-line mode (-d=batch) on Linux and you kill the terminal 
window the code can appear to crash. A traceback is generated and you have to confirm the exit.

In fact this is not a crash, ‘hanging up’ the terminal creates a signal that is caught by the error 
handler, giving the appearance of a crash, but the process is benign.
To avoid confusion this is now treated as a variant on the normal way of exiting the code, which 
it now does immediately without any further reports or dialogue.

 Case 56929

A crash in PRIMER has been fixed. It happened when using *DEFINE_TRANSFORMATION 
with MATRIX option if any Mij field had parameters.

Read

 Case 57338

An issue with tessellation of planar surfaces using conic arcs on a trimming loop has been fixed.

 Case 55975

The [Model, read] Scan_All function did not work correctly when an include file contained PGP 
encrypted data at the start of the file. Now fixed.

Scripting

 Case 57329

When creating a new analysis register Excel file using the Analysis Tracking Tool, the drop-
down for spreadsheet tabs in subsequent uses of the tool would populate incorrectly and would 
require refreshing the list to read the correct tabs in the selected Excel file. This has now been 
fixed.

 Case 57212

Ejection Mitigation tool threw error if the model contained a PART with no structural elements 
(Section or Material) defined in it. Fixed it.

 Case 56989

If Widgets in windows went out of scope, they could get garbage collected and become 
unresponsive. They should have been protected from garbage collection. Now fixed.
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 Case 56849

Previously when using the HPM panel with a large font size the Seat facing direction option text 
could get truncated. This has been fixed.

 Case 56729

The HRMD tool panel would disappear upon selecting the current model using the ‘Check 
results from a previous analysis’ option. This has been fixed.

Seatsquash

 Case 56924

While positioning a Dummy/HBM, if the model is rotated along the Z-axis by 180 degrees, then 
the positioned model is not created appropriately. Fixed this.

Sections

 Case 56180

True Section display now works for beams with ELFORM=13.

Sets

 Case 56804

In models with *SET_XXX_COLLECT the object menu correctly lists the master sets and omits
the child sets which are for internal use only. However, the screen pick for sets was incorrectly 
offering child sets. If the pick was off a drop-down then the illegal large negative label of the 
child set could cause corruption of the keyword. Child set collect is now excluded from picking.

 Case 56666

The order of *SET_XXX_COLLECT reversed each time the model was written out. Whilst this 
did not change set labels or contents it caused problems for those who use file comparisons to 
find changes in a model. Fixed.

 Case 56123

Editing a *SET_XXX_COLLECT definition could result in that set wrongly being deleted 
during a Cleanup Unused operation.
This was due to an error in the set editor for _COLLECT sets, now fixed.

T/HIS → PRIMER Link

 Case 57449

When a curve was sent from T/HIS to PRIMER in a link session, PRIMER was showing a 
message that curve 0 from T/HIS had been received, instead of writing the actual T/HIS curve 
index. Fixed.
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 Case 56746

Added binout* filter to file selector in PRIMER-T/HIS link to allow detection of files like 
binout1, binout2, etc.

Transform

 Case 57225

In models containing include files and mutable parameters the order in which include file 
*INCLUDE statements were written to file could be reordered unnecessarily.

This was because PRIMER has to consider the ‘scope’ of mutable parameters, i.e. where they are
current, which requires it to ensure that the right parameter statements are output before an 
include file which uses them. This logic was making some incorrect deductions when 
*DEFINE_TRANSFORMATION and *INCLUDE_TRANSFORM were present in a deck 
containing mutable parameters, resulting in the wrong output order. It has now been fixed.

User Interface

 Case 56814

Text for selected rows in tree views in the classic theme had the wrong colour, which made it 
unreadable. Now fixed.

 Case 56798

In PRIMER’s Part Tree, when you pick some items, odd UI graphics were displayed. Fixed.

 Case 56795

Recent releases of RedHat Linux 9 (RHEL 9) use a desktop compositor to manage graphics 
when running the default Gnome desktop. This contains some errors which result in popups in 
PRIMER sometimes not containing any contents.

Typically such systems are used for remote visualisation using a ‘thin wire’ connection 
technology such as VNC or Nice DCV and the problem shows itself when using such tools.
We have not found a fix for in RHEL 9 (other than using a desktop environment that is not 
Gnome) so instead we have introduced a modification to all the Oasys software which performs 
some extra, redundant operations when a popup is mapped which seem to trick these systems 
into displaying them properly.

This needs to be configured via environment variable SM_POPUP_EXPOSE. Please contact 
Oasys Ltd for help if you encounter this problem and we will give advice on configuration.
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2.2 D3PLOT

2.2.1 Bugs fixed in 22.0

Animation

 Case 55712

The File/Anim/Draw dropdown option and the options in the T/HIS panel during the linked 
session now work even during animation playback.

 Case 55240

Previously when animating the results of two implicit models in a window, using interpolation 
by time to ‘slow down’ their movement visually and magnification to make their displacements 
more visible, the 2nd model could fail to be interpolated correctly.

This was due to the combination of multiple models in a window, interpolation, magnified 
coordinates and – crucially – the presence of *DATABASE_CROSS_SECTION. The 
calculation of the magnified cross section geometry, which uses state 1 as its ‘undeformed 
geometry’ for displacement calculation, was corrupting the interpolation factor for the second 
model.

Fixed by changing the way the state 1 coordinates extracted for the database cross section 
magnified displacement calculation.

Annotations

 Case 55826

If an incompatible or corrupted annotations file was read into D3PLOT previously, an error 
message is shown, but D3PLOT could leave some data relating to these corrupt annotations in 
memory. Continuing with the session could lead to further confusing and spurious errors and 
warnings. This has been fixed so that corrupt annotations are now flushed from memory.

 Case 55377

If the window order was changed from default and an annotation was captured, when the 
annotation was reloaded the modified window order would not be remembered. This has been 
fixed.

 Case 55307

If a model with an annotation marked on part A was drawn in multiple windows and part A did 
not have the same blanking status in all windows, moving the mouse cursor between windows 
would cause the annotation marker in any window where part A was blanked to jump between 
the centre of the part and the origin previously. This has now been fixed so annotation markers 
will be drawn at the centre of the visible elements of the part in windows where at least some of 
the part is visible and at the true centre of the part in any windows where the part is fully 
blanked. This stops any apparent ‘jumping’.
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Blanking

 Case 53029

Fixed a bug where the blanking lock status was not preserved in D3PLOT when unblanking 
entities in PRIMER through the link (and vice versa).

Blob Plots

 Case 56141

Some number format options for external data did not work very well with multiple models. 
Sometimes the data value format shown on the panel might be the format for the wrong model 
when different models are set to different formats. When the popup for the data value number 
format was opened multiple times in a session, sometimes it was completely blank. These 
problems have now been fixed.

Capture

 Case 55784

Previously when capturing an animation to the ‘Add item’ row in D3PLOT, an image would be 
captured instead. This has been fixed.

 Case 55696

Previously when D3PLOT was first opened, if the File Open panel was closed without opening a
model, then opened again and a non-existent filename was entered into the filename textbox, 
then the file open panel was closed, D3PLOT would crash. This has been fixed.

Component

 Case 54573

If a thermal analysis (no displacements, velocities or accelerations) was read into D3PLOT, the 
initial component selected for the ‘Vel’ TAB in D3PLOT used to be the first Vector component 
available in the model (usually Temp Flux Vector).

The ‘Vel’ TAB is meant to be a special plotting mode that should only allow Velocity (default), 
Displacement and Acceleration vectors to be plotted via the ‘Vel’ button. All other Vector 
components should be selected via the ‘Vector’ TAB and plotted via the ‘Vec’ button. This has 
been fixed.

Contacts

 Case 55864

Previously, contact nodes were sometimes drawn on the omitted side of a cut section. This 
happened in a vector plot of contact forces. Now the contact nodes are omitted as expected.
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 Case 55703

Vector plots of contact force at nodes were not working in a model when both structural 
elements and contact segments (attached to the same nodes) were both visible. Turning off the 
display of the structural elements restored the visibility.

Now fixed: Vector plots like this will now work so long as the nodes at which they occur are on 
unblanked elements / segments of any sort.

Contour

 Case 55836

The contour values on solid elements were calculated incorrectly if the default averaging options
were changed and the ‘Part Ignored’ and ‘Blank Ignored’ options were turned off.

The mid-side and corner values for solids with multiple integration points were not calculated 
correctly if ‘high resolution’ contouring was turned on. This has been fixed.

 Case 55809

Type 23 shell elements have multiple on-plan integration points. If results were output for all on-
plan integration points, D3PLOT did not correctly display the results. This has been fixed.

Cut Sections

 Case 56483

On the cut section custom spacing panel, the position showing 0.0 for the local cut origin is 
disabled. In some cases, another plane position was disabled instead of this. This could happen 
when there are two positions on the panel, where the first was positive and the second is 0.0, i.e. 
when the positions are not sorted after editing, and then the number of planes was increased. In 
this situation negative values are added to the end of the list. After clicking ‘Sort positions’ the 
first position with a negative value was disabled instead of 0.0. This has been fixed.

 Case 56292

Drawing true 2D capping thicknesses for a cut section crashed in a model with contact surfaces 
in the drawing modes Sh, Li and Hi. Now, they are drawn with fixed thickness even when 
another thickness option is selected. This is the same behaviour as for the drawing modes CT and
SI and fixes the crash.

 Case 56176

Traces for nodes and other items sometimes crashed D3PLOT when cut sections were turned on 
in multiple directions. This has now been fixed.

 Case 55776

The screen space option for cut sections has now been removed because it was not used very 
much and did not work as intended.
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 Case 55767

Union or intersection mode for cut sections was not saved in settings files. This support has now 
been added.

 Case 55602

When a cut section is defined by the Ansys LS-DYNA method and then the location is imported 
from a *DATABASE_CROSS_SECTION, sometimes, D3PLOT reported a false error: ‘Normal 
and edge vectors are collinear.’ In those cases, the cut plane location was not updated as 
expected.

Even when this error did not appear, the edge head vector could have been incorrect. As normal 
tail and normal head were correct, this gave the correct plane location visually, but the local X 
and Y axes in the plane could be rotated unexpectedly. This would have affected the output of 
forces and moments.

Now the cut plane location is updated as expected.

 Case 55583

On the cut section panel, planes can be defined by the Ansys LS-DYNA method with an 
imported *DATABASE_CROSS_SECTION. This button only ever updated the plane definition 
for the first direction D1, but not for D2 or D3. Now, it updates the plane for the direction whose 
tab is currently selected. Issue fixed.

 Case 55472

The force output on the cut section panel was incorrect when thick shell elements had significant
stress in their local Z (thickness) direction. The calculation has now been improved to better 
match the *DATABASE_CROSS_SECTION forces output by Ansys LS-DYNA in the binout 
file.

 Case 54355

A new Element Capping thickness mode has been added in D3PLOT to fix the previous issue of 
having noticeable pauses during cut section operations. This mode reads in the true thickness 
value from ZTF file and is constant across all states of the analysis. The order of element 
capping in the UI has slightly changed and a new preference for true thickness constant scale 
factor has been added.

 Case 54275

The Union/Intersection radio button is now disabled when “Basic space” is selected. When 
Intersection is selected in “Deformed space” and then when switched to “Basic space”, we 
automatically switch to Union.

 Case 54064

Made changes so that the basic/deformed space switch applies to all the cut-section directions 
together.

 Case 53563

When a cut plane was close to the plane of the screen, the mouse needed to move quite far to 
achieve a relatively small visible change when the plane was dragged sometimes previously. 
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Now, the plane origin is moved such that its projection on the screen plane corresponds to the 
mouse movement.

When the plane is exactly the plane of the screen, the behaviour is still determined by 
UP/RIGHT for the positive direction and DOWN/LEFT for the negative direction. The angle 
tolerance when this behaviour happens has also been tightened from about 8 degrees to about 0.8
degrees for consistency with PRIMER.

Data Components

 Case 55271

Previously, if a vector plot of a contact data component was plotted, no vector arrows were 
displayed if the shell, thick shell or solid elements that the contact segments were on were also 
being displayed, but the contour bar would correctly show the component and range of contour 
values. This has been fixed.

Dialogue Commands

 Case 56151

Dialogue commands to interact with nodal rigid bodies were failing to process the string ‘nrbs’ 
correctly (noting that dialogue input is not case sensitive). This has now been fixed so that both 
‘nrb’ and ‘nrbs’ can be used to access these entities.

Envelope

 Case 55710

The following Part Data components were plotted incorrectly for thick shells: 
KE_KINETIC_ENERGY, IE_INTERNAL_ENERGY, TE_TOTAL_ENERGY, GMASS, 
GVX_X_VELOCITY, GVY_Y_VELOCITY, GVZ_Z_VELOCITY, 
GVR_VELOCITY_RESULTANT, GMX_X_MOMENTUM, GMY_Y_MOMENTUM, 
GMZ_Z_MOMENTUM, GMR_MOMENTUM_RESULTANT, MD_MATERIAL_DENSITY, 
MM_MATL_MODULUS, MP_MATL_POISSONS_RATIO, MY_MATL_YIELD_STRESS, 
MF_MATL_FAILURE_STRAIN. They have been fixed.

 Case 51733

Suppose that a subset of states has been selected in the envelope options in the Data menu – for 
example, only the states with odd numbers. Then, if envelope options are opened in the Write 
menu and then we switch back to the Data menu, the states selected became confused. Now, the 
state selections for enveloping on the Data menu and for enveloping on the Write table are 
independent of each other and do not change when we temporarily open another menu.

FEMZIP

 Case 55559

When a file with extension ‘.d3plot.fz’ was opened in D3PLOT, e.g. “job_name.d3plot.fz”, the 
T/HIS link did not find files “job_name.binout0000” etc. This has now been fixed.
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Similarly, for “job_name.d3plot.sdf”, which is another common naming convention for files 
from FEMZIP, the T/HIS link now finds “job_name.binout0000” etc.

Filename

 Case 56219

The Filename textboxes in ‘RECORD COMMAND FILES’ and ‘PLAYBACK COMMAND 
FILES’ panels did not accept filenames with very long paths. This has been fixed.

 Case 55671

When we open a ‘.d3ssd’ file in D3PLOT and then attempt to open another new model via ‘File 
→ Open New Model,’ the ‘File filter’ in the OPEN PLOT FILE window was incorrectly 
displayed as ‘*.db’ instead of ‘*.d3ssd’. This has been fixed.

 Case 55507

Previously when choosing to open ‘Multiple Models’, D3PLOT listed *.ctf and *.ptf files as 
separate models. This has been now fixed to behave as follows:

- When a directory contains both *.ptf and *.ctf files, D3PLOT will list only *.ptf files
- D3PLOT lists *.ctf files only when the:

o ‘File filter’ is chosen as *.ctf
o Search directory has no result files other than *.ctf files or ctfiles
o Search directory has extra *.ctf files or ctfiles whose matching pair of *.ptf file or 

‘d3plot’ file does not exist

 Case 55469

When opening D3PLOT with a session file, it was not possible to select FEMZIP files without 
the ‘.fz’ extension, e.g. Zd3plot, as D3PLOT would not recognise these as valid results files. 
Now, result files with any filename convention can be opened. D3PLOT will check files are 
valid before attempting to open the session file.

Graphics

 Case 56284

Previously when animating, moving the mouse into the graphics window could slow the 
animation down whenever the cursor moved. This was because it was attempting to ‘predictive 
pick’ the item under the mouse which was not sensible or useful when the image was moving 
and consumed considerable CPU.

Fixed by ignoring mouse motion with no button pressed in a graphics window that is animating.

 Case 56156

With true sections turned on for beams, if a nodal component was plotted on discrete beams 
using SI or CT, the contour colours at both nodes would be the same and correspond to the data 
value at N1. This has been fixed so that the contour colours at the ends of the discrete beam 
correspond to the data values at the ends.

                    
DOCUMENT3

Page 42



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

 Case 55867

If the Opacity switch was turned off for a CT/SI/VEC plot of a Contact data component, the 
Shells and Solids were still drawn 100% transparent if an SH plot was done afterwards.

To make the Shells and Solids re-appear it was necessary to turn Opacity back on. This has been 
fixed.

Help

 Case 56069

Corrected some Help texts in Display → Options.

Image

 Case 55885

D3PLOT would crash if a background movie or image was read in and displayed in a window 
which did not contain any visible models, if Quick Pick was active and the cursor was moved 
into the window containing the movie. This has been fixed.

JavaScript API

 Case 55511

Using the global GetData() JavaScript API function threw an exception when specifying the 
entity type using the Type class constant Type.NODE. This has been fixed.

 Case 55026

When running D3PLOT through command file, D3PLOT can now read the JavaScript argument 
without needing to have a model.

Labels

 Case 54517

For each node, the data value and nodal coordinates labels overlap, making it difficult to read. 
Now, they are mutually exclusive options which you can toggle between.

Measure

 Case 54446

To make things clearer in the Measure panel, we removed the words ‘Disp’ from the Mag Vals 
and Vect Vals tick boxes. Additionally, when the reference state switch is on, the reference state 
number can now be seen next to the Measure magnitude values.
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Menus

 Case 55221

On Windows, any D3PLOT child windows that are dragged out onto the desktop appear as mini 
preview windows when you hover over the [D3] icon on the Windows taskbar. Each preview has
an ‘X’ which if clicked on will close the window in question.

This went wrong in two ways:

(1) ‘Always there’ windows such as the Part Tree in D3PLOT disappeared and could not be 
re-instated – the dialogue box and graphics windows suffered the same fate.

(2) In some cases, the fact that the window was no longer there could cause a crash when 
D3PLOT tried to use it because it did not ‘know’ that the window had been deleted.

These are now fixed. ‘Always there’ windows will now be removed from the desktop by 
remapping them inside the D3PLOT master window, so they are moved rather than deleted. 
Windows which can be deleted legitimately, for example Open new model popup menu, is now 
deleted in a way which D3PLOT ‘knows about’ so there are no internal inconsistencies.

 Case 55119

Previously, if the Part Tree was undocked and the Data tab was clicked, the Part Tree would be 
closed. This has been fixed.

 Case 54367

The three tick boxes for the direction of cut section planes were getting mapped behind the 
Exclude Select Parts panel in the Cut Section menu. Now fixed.

Morphing

 Case 52739

Added eigenmode controls to the Deform → Magnify panel allowing you to modify these 
magnifications after the model has been read in. Issue fixed.

Part Tree

 Case 54634

If you had two models open in two windows (M1 → W1, M2 → W2), used the Part Tree to 
right-click and select assemblies in M1 to ‘Only’ in the window, then tried to do the same for M2
to show only the same assemblies, this turned off the entities in W1 so only W2 was displayed.

In D3PLOT 22.0, the right-click popup menu in the Part Tree has been modified so that instead 
of having an ‘Only’ button it now has two buttons:

‘Only – (All Models)’
‘Only – (This Model)’

‘Only – (All Models)’ is the same as the old ‘Only’ button and everything in all models apart 
from the item selected is blanked.
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‘Only – (This Model)’ blanks everything in the model you have selected the item in apart from 
that item but leaves the blanking in any other models as it was.

Program Crash

 Case 56496

The dialogue command /BLANK STATUS crashed D3PLOT when a model with contacts was 
open. Now fixed.

 Case 55462

If a model was animated by interpolated time, and the frame times closely coincided with state 
times, D3PLOT could sometimes crash when the animation was paused. This has been fixed.

Python API

 Case 56552

In the D3PLOT API, none of the properties were read-only. Now, those which should be read-
only have been made read-only.

Quick Pick

 Case 56305

Previously, for the first time the ‘Drag’ option was selected in the Cut Section menu, the drag 
operation was cancelled as soon as the mouse was moved into the graphics window, and you had
to reselect the ‘Drag’ option a second time. This only happened the first time ‘Drag’ was used in 
a session. This has been fixed.

 Case 55711

D3PLOT would crash if a background movie was read in and displayed in a window which did 
not contain any visible models, if Quick Pick was active and the cursor was moved into the 
window containing the movie. Now fixed.

Read

 Case 55628

Using the PENOUT or ENGOUT fields on *CONTROL_OUTPUT (or *CONTACT) generates 
penetration and energy density data at nodes for _MORTAR contacts.

Using the KINENG field on *CONTROL_OUTPUT generated kinetic energy data at nodes.

D3PLOT will now read and display d3plot/PTF files containing these data.

 Case 51760

D3MAX files are now included in the list of valid input types to read into D3PLOT.
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Recent Files

 Case 55477

A ‘Recent Files’ dropdown has been added to D3PLOT’s Background Images/Movies menu, 
allowing to easily select a file from recently browsed images or movies.

Scripting

 Case 56024

The GetData() function in JavaScript used to crash in D3PLOT when the current model has no 
window. It is now fixed.

Selection

 Case 54354

When picking entities in the graphics window for some Deform and Utilities tools, it was 
sometimes not possible to cancel the picking action without quitting the whole tool or switching 
to a different tool. In some cases, it was possible to cancel the picking action, but once cancelled,
it was not possible to restart it again. These issues have now been resolved.

Session

 Case 54837

Reading an OP2 file (from Nastran) into D3PLOT, then updating and rereading the file can 
result in the ‘old’ (unchanged) file still being read.

This is more likely to happen when the file is on a network drive and is because the operating 
system is preventing the new file from being ‘seen’ by D3PLOT. While unproven, it seems 
likely that this is because D3PLOT leaves OP2 files open for further read operations, effectively 
locking access to the ‘old’ file on disk.

This has been fixed by adding auto-close logic to OP2 files. If no access is made to the file for a 
while, the file stream is silently closed, allowing the operating system to unlock it. If the file is 
accessed again, for example to read data at a different loadcase, it is silently re-opened then re-
closed if is subsequently becomes idle again.

Settings File

 Case 56258

When the D3PLOT-T/HIS link was open and a T/HIS graph was made the child of a D3PLOT 
window, upon closing the D3PLOT model, D3PLOT would crash. This has been fixed.

Streamlines

 Case 55896

If a set of streamlines was created where the source was defined by picking a node then the start 
position of the streamline was not calculated correctly and often resulted in an incorrect error 

                    
DOCUMENT3

Page 46



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

message that none of the streamline start positions were inside the fluid volume. This has been 
fixed.

User Interface

 Case 55851

Choosing Properties in the Tools menu and clicking on the Contours option will now open the 
Data panel and make the ‘Contour Levels’ option tab active. Issue fixed.

 Case 55770

D3PLOT printed errors in the command prompt window when a new model was opened by 
setting custom states. This issue has been fixed.

 Case 55239

If you exited T/HIS in a linked D3PLOT-T/HIS session while the D3PLOT Layout menu was 
open, the menu did not refresh itself to remove any buttons it was displaying for T/HIS graphs. 
This has been fixed.

 Case 51690

Changed the old ‘Magnification Switch’ toggle on the ‘Deform → Magnify’ panel to the new 
‘Display Magnification Factor’ tick box. Issue fixed.

 Case 50297

The button label was mapped on the right-hand side of the text input buttons in the ‘Set Times’ 
and ‘Set States’ panel. Swapped them to avoid confusion.

 Case 49218

The Components box will now say ‘Multiple components’ if multiple components are selected 
using the ‘+’ option. Also, disabled the component box to prevent single selection. The 
Component box gets re-enabled when the multiple selected components are removed until only 
one is left, through the multiple component selection page accessed by ‘+’.

Renamed the ‘Apply’ and ‘Cancel’ buttons in the Select Multiple components page to ‘Apply 
Select’ and ‘Cancel Select’ respectively. Issue fixed.

Variables

 Case 56568

D3PLOT could crash if user clicked 'New Window' button in the REPORTER panel when a 
D3PLOT or T/HIS item was selected. This has been fixed.

Workflows

 Case 56409

Fixed an edge case for the ‘Strength Check’ Workflow: if the workflow model is found in more 
than 1 window, the script now exits automatically.
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 Case 56211

Fixed an edge case for the ‘Eroded Elements’ Workflow: if the workflow model is found in more
than 1 window, a warning message is now issued.

Fixed an edge case for the ‘Eroded Elements’ & ‘Strength Check’ Workflows: if the workflow 
model is not found in any window, the script now exits automatically.

Write

 Case 54495

It was previously possible to write keyword data with enveloping enabled. This resulted in 
garbage output and has now been prevented.

XY Data

 Case 48199

In the XY data panel, if we select certain data components and entities, navigate away, then 
return to the same panel, the components/entities selections are now retained, unlike previously 
where the selections were reset.

2.2.2 Bugs fixed in 22.1

Annotation

 Case 57625

Fixed a crash that could occur when reloading an annotation with markers on parts.

 Case 56762

D3PLOT annotations files created with later versions of D3PLOT may not read correctly into 
older versions of D3PLOT. Previously no warning was displayed. Now, a warning message is 
printed to the dialog box if an annotations file is read that was written with a more recent version
of D3PLOT.

 Case 56748

When an annotations file was saved, no confirmation message was printed to the dialogue box. 
This has been fixed.

Blanking

 Case 56806

Fixed an issue in the D3PLOT-T/HIS link preventing blanking of more than one model when the
‘Display only’ option was selected in Quick Pick options.
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Component

 Case 57182

TSHELL elements now correctly alter their contour min/max labels upon switching between 
integration point layers for SHELL_EXTRA components.

Likewise, XY data will also now correctly output data for the requested integration point for 
TSHELLs while trying to output SHELL_EXTRA component data.

Cut Section

 Case 56917

Fixed a crash that could occur when opening the cut section forces table in a session with 
multiple models when a model had been removed.

 Case 56166

When 2D true capping thicknesses for cut sections were drawn, D3PLOT did not consider 
offsets from *ELEMENT_SHELL_OFFSET. Now D3PLOT draws this offset as expected when 
the model has got a .ztf file. The offset is then drawn similarly to that defined by NLOC on 
*SECTION cards.

Data Components

 Case 57230

Extracting shell or thick shell results for max/min/mag through thickness IPs could result in a 
crash. This has been fixed.

 Case 57195

In D3PLOT 22.0, if the data component was changed before a model had been loaded, e.g. via a 
JavaScript, D3PLOT could crash. This has been fixed.

 Case 56802

When a settings file was saved in a D3PLOT session with external data and then a model with 
that settings file was read in a new session, D3PLOT showed a contour bar with external data, 
but on the ‘External data’ panel in the Utilities menu the buttons to turn off external data were 
disabled.

Now external data is not automatically turned on by reading a settings file because the data can 
be reinstated by reading a .blob file. When .blob files are read, the buttons on the interactive 
panel to turn on or off display of the data are available as expected.

Dialogue Command

 Case 57277

The dialogue command to switch the header on or off did not work for windows containing 
multiple models. This has been fixed.
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 Case 57236

When envelope plotting was turned on and back off with dialogue commands and then the data 
component was changed, sometimes the contour ranges persisted from the previous data 
component. Now, D3PLOT shows the correct contour ranges when envelope plotting is turned 
off with the dialogue command /ENVELOPE COMPONENT OFF.

 Case 56972

Fixed an issue affecting Data menu updates triggered by data components selected via dialogue 
commands.

 Case 56627

The dialogue commands UTILITIES USER_DEFINED_NAME ADD and UTILITIES 
USER_DEFINED_NAME DELETE did not process ranges like ALL or ‘start’ TO ‘end’ as 
expected. Now all items in the range are processed as expected.

 Case 56577

In a model with multiple element types, the dialogue commands ‘UTILITIES 
USER_DEFINED_NAME ADD’ and ‘UTILITIES USER_DEFINED_NAME DELETE’ could 
cause a crash for some element types. This has now been fixed.

Envelope

 Case 57120

Fixed a crash when trying to plot an envelope plot for a model with binout files and without a ztf
file.

FEMZIP

 Case 57576

Fixed an issue that could occur when combining Deform → Shift Deformed and Deform → 
Transform in a model compressed using FEMZIP, resulting in spurious deformations.

Graphics

 Case 57191

Fixed an issue affecting the handling of dynamic beam labels.

 Case 57111

In D3PLOT 22.0, autoscale did not recognise when airbag particles were switched off in the 
entities panel. This has been fixed.

 Case 56490

Fixed an issue causing labels to disappear in part-screen mode when they reach the edge of the 
graphics window.
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Groups

 Case 57015

D3PLOT crashed when groups were created in a model with multiple file families like from 
adaptive remeshing. Now, D3PLOT reports an error message that groups are not supported on 
such models.

 Case 56603

When groups are created with the JS API constructor in the Group class, by default they get the 
next free labels in the session. In the corresponding .grp file in the model directory the labels 
were all zero, which can be seen when the model is closed and reopened in D3PLOT. Now, the 
labels in the .grp file match the interactive ones as expected, so the behaviour is the same after 
reopening the model.

Help

 Case 56297

Improved the Help content in Display → Options.

Image

 Case 55828

D3PLOT could crash when exporting a GLB file for a model containing solid elements with 
topology N1, N2, N3, N4, N5, N5, N5, N5. This has been fixed.

 Case 55825

Fixed an issue causing labels to become distorted when saving .png images at 2X or 4X.

Integration

 Case 57466

When D3PLOT tells PRIMER to open a model, PRIMER should display the model using the 
same colour, blanking, and other visibility properties as D3PLOT. In practice, this was 
unreliable, especially when opening multiple models across the link, or when disconnecting and 
reconnecting linked sessions. For instance, if a keyword file had PRIMER part colours 
embedded as comments, these would sometimes get picked up by the parent D3PLOT session, 
despite being correctly ignored by PRIMER. This has now been fixed, so the parent program will
dictate visibility, colour, and drawing mode properties upon opening a model in the child 
program or connecting with an existing model.

JavaScript API

 Case 57299

When a d3plot/.ptf file written from PRIMER was opened in D3PLOT and then the JavaScript or
Python API function Beam.Deleted, Shell.Deleted, Solid.Deleted or Tshell.Deleted was called, 

                    
DOCUMENT3

Page 51



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

D3PLOT crashed. Now these functions return false because these models only have got one state
and therefore elements are never deleted.

 Case 57243

The IntegrationPoints property on the Beam JavaScript API class incorrectly had the value 0 
when the model had no .ztf file or when the .ztf file had some unrecognised options for 
ELFORM and IRID on the section definition of the beam. Now, the correct number of 
integration points is returned when IRID on the section is 3.0, 4.0 or 5.0 or when ELFORM is 5. 
In other cases where previously 0 integration points were returned, D3PLOT now returns the 
number of integration points for which Ansys LS-DYNA has written data to the d3plot/.ptf file.

 Case 57233

When the JavaScript API function Tshell.GetData was called with positive ‘ip’ on the options 
object for an explicit integration point number, sometimes there was an exception that the ip 
value was out of range (1 - 0). Now that function returns the expected data value when ip is 
between 1 and the number of integration points.

 Case 57181

The JavaScript API constant Component.CAREA for contact segment area was not recognised 
by scripts although it was in the documentation. Now fixed.

In contour plot the values for CA_CONTACT_AREA were sometimes shown as zero on state 0. 
The values are still shown as zero on later states when the underlying elements of contact 
segments are deleted, but at state 0 we now get the correct area calculated from the undeformed 
nodal coordinates.

 Case 57037

The JavaScript and Python API functions GetData and GetMultipleData on the Node, Shell, 
Beam, Solid etc. classes returned garbage data or crashed D3PLOT when the ‘state’ property of 
the underlying model was 0.

For nodal coordinates and a few components derived from that, for example area of a shell, the 
values have been correct at state zero.

For other data components there is now an exception when they are extracted at state zero with 
GetData or GetMultipleData.

 Case 57036

When the JavaScript API function Shell.GetData or TShell.GetData is called with no integration 
point ‘ip’ specified, then the layer selected on the Data menu is used. This worked for the top, 
middle or bottom surface or explicit layer numbers Layer 1 etc.

When Max All, Min All or Mag All was selected, the return value from GetData was 
unexpected. Now the function returns the maximum, minimum or extremal magnitude across all 
layers for these options as expected for scalar data components.

 Case 56910

The ‘state’ property of the Model class was incorrectly read-only. This has now been fixed.
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 Case 56859

In the JavaScript API Segment objects, the ‘label’ property was returned as null because contact 
segments don’t have labels in Ansys LS-DYNA. This has now been changed such that we 
always have s.label == s.index + 1 for every Segment object s.

In other words, labels are obtained by assuming that they are always sequential starting at 1. This
is consistent with the existing behaviour of Segment.GetFromID because now 
‘Segment.GetFromID(m, s.label)’ will return the same segment s as we started with, like it 
would be the case for other entity types.

 Case 56790

When Contact objects were flagged with the JavaScript API function SetFlag or ClearFlag and 
then Contact.BlankFlagged or Contact.UnblankFlagged was called, the blanking was not as 
intended. This has now been fixed.

Also Contact.GetFlagged could have returned an unexpected list, where now it returns whatever 
has been flagged in the script previously.

 Case 56637

In a JavaScript or Python script, the function AllocateFlag sometimes returned the same value 
multiple times. Therefore, flags which should have been different in a script could have been the 
same. Now fixed.

 Case 56636

Modified function Part.GetAll() to return only parts, excluding NRBs from the result.

 Case 56562

In the new object-oriented JavaScript API and Python API, the functions Blank, BlankAll, 
BlankFlagged, Blanked, Unblank, UnblankAll and UnblankFlagged did not work as expected for
some entity types (e.g. Contacts). Now fixed.

 Case 54616

Extracting minimum principal stress from solid elements via JavaScript could result in 0.0 values
being extracted instead of the actual values. This has been fixed.

Labels

 Case 57201

When swapping between Interpolated and Simple TSHELL surfaces, the Min/Max labels were 
not correctly updating without an explicit refresh of the graphics window. This has now been 
fixed.

Measure

 Case 57170

When running a JavaScript which calls ‘Measure()’ followed by ‘Measure.Delete(index)’ each 
time in a loop, the Quick Pick button updates, this results in the quick pick button getting 
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updated more often and after this loop runs for 100 times we get an error message for the 
remainder of the loop. Now fixed.

Menus

 Case 56927

Fixed a bug where sometimes the material attributes panel will lose parts within its part selection
menu when multiple models are present.

Multiple Windows

 Case 56618

D3PLOT crashed when a multiphysics model was read in with cut sections turned on and then a 
new graphics window containing that model was added. This has now been fixed.

Multiple Models

 Case 57556

There were some models where the number of springs in the binout0000 file was less than the 
number from the .ztf files. When such a model was opened in D3PLOT, it sometimes crashed or 
caused other unexpected behaviour. This has now been fixed.

 Case 57513

When working with multiple models in the same window, use the blanking tool (via the RHS 
menu) and then issue an autoscale, D3PLOT would crash. This has been fixed.

 Case 57364

When two models were open in the same window where at least one contains groups, quick pick 
area selection of groups could crash. This has been fixed.

 Case 57043

D3PLOT crashed when loading models with ‘User defined OTHER components’ and has 
one/more of the following 5 entities; Spotweld, SPC, Springs, Seat Belts and X Section.
This has been fixed.

 Case 56801

If multiple models were displayed in the same window, then it was not possible to turn ON/OFF 
the ‘Freeze Coordinates’ for individual models in that Window (ON/OFF could be set for 
different Windows).

Now this control has been added using the ‘Selected Model’ option in the menu. If ‘Selected 
Model’ is set to a specific model instead of ‘All Models’ then any changes to the ON/OFF switch
are only applied to that model instead of all the models in the window.
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Output

 Case 56838

Previously, the state selection popup menu in the Images → D3PLOT Viewer tab with 
Annotations selected did not change the state selection of the exported annotations. The popup 
now offers you the choice to export annotations using the state selection defined when the 
annotation was captured, or to export all annotations with all states, or every 2, 3, 5 or 10 states.

Part Tree

 Case 57129

Fixed an issue in the Part Tree when right-clicking on model name and then colour all by 
material resulted in lots of scrolling text and a terminal lock-out.

 Case 56617

Fixed an issue affecting the “ALL Models” option in the Part Tree popup for part assemblies.

Program Crash

 Case 57130

Picking include files by area could sometimes cause a crash when multiple models were in the 
same window and only one of them contained solid elements. This has now been fixed.

Properties

 Case 56584

In properties panel, clicking ‘==>’ should propagate properties from the selected model to rest of
the models. This was working as expected only when M1 was selected and did not propagate 
properties from any other models (say M2, M3 so on). This has been fixed now.

Python API

 Case 56911

When getting the ‘name’ of a Contact object in the JavaScript or Python API and the contact 
type information was not available from the .ztf file, D3PLOT crashed. Now this property 
returns null in those cases.

Read

 Case 57624

If D3PLOT was slow to start, for example if it had to wait a long time for the network licence 
server to respond, it was possible to ‘drag and drop’ a filename into the desktop window while it 
was still initialising and before it was ready to process it. Depending on when this happened it 
could crash D3PLOT.
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This has been fixed. D3PLOT will now reject a premature drag-and-drop filename with a 
warning message in the dialogue window that it has not yet initialised.

 Case 56684

D3PLOT could display incorrect values of von Mises stress and other derived components 
(max/min principal stress, von Mises strain, engineering major/minor strain for shells) for 
D3SSD analysis with BINARY = 2 (complex results). This has been fixed.

Rigid Bodies

 Case 56688

When entities were switched off via the entities panel, nodes could sometimes still be screen-
picked, e.g. when creating a Trace. This has been fixed.

Shortcut

 Case 53093

Undo Quick Pick can now be assigned and used in shortcut keys, default being ‘U’.

T/HIS Link

 Case 57521

On Linux systems, when attempting to open the T/HIS link within D3PLOT and the T/HIS 
executable is either not present or is inaccessible due to not having sufficient permissions, 
D3PLOT would crash. This has been fixed.

User Interface

 Case 57445

When dragging cut sections, the cursor symbol changes to a ‘drag’ cursor. However, when 
dragging was turned off, or cut sections were turned off, or the cut section panel was dismissed, 
the cursor symbol did not revert to the correct Quick Pick one despite this being the current 
picking mode. Now fixed.

 Case 56738

Removed a white space ahead of “Sets” on the Quick Pick drop-down.

 Case 56234

Fixed inconsistencies in the appearance of buttons to select measurement type in the Measure 
tool.

 Case 55468

If the D3PLOT button in REPORTER was clicked twice in succession, D3PLOT would lock 
with the Open Plot File panel open. This has been fixed.
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Views

 Case 56587

When the transparency of all parts in a model was changed and an Only operation was 
performed on any of the entities, D3PLOT incorrectly rendered the spotwelds along with the 
selected entity. This has been fixed now.

Volume III

 Case 56935

D3PLOT crashed when opening the Measure panel in a model with Volume 3 parts. This is now 
fixed.

 Case 56881

When Quick Pick → Only was performed on any of the Volume 3 elements, D3PLOT blanked 
the whole model. Also, Quick Pick → Undo was not working for Volume 3 elements when using
‘Only’. These issues have been fixed now.

Workflows

 Case 57219

When reloading a REPORTER item in D3PLOT, if further models were opened via JavaScript 
commands operating on these models, e.g. setting the current model via dialogue commands, it 
would not work with these models. This has been fixed.

 Case 55055

If the Eroded Elements workflow was used for a model that was not in a window, other 
scripts/workflows that were running could become unresponsive. Now fixed.

Write

 Case 56803

When writing keyword data from D3PLOT, if the model contained large labels, the data was 
sometimes written in large format with 20 columns per data field, but the long=y after 
*KEYWORD was missing. This has now been fixed.

XY Data

 Case 49104

The Surface layer has been removed from the curve axis label and been included into the curve 
(name) label.

The curve names from XY Data are made to be in consistent with T/HIS on how they append the
‘surface layer’ and ‘integration point’ data.

For surface layer (only for SHELLs and TSHELLs) the following short forms are appended to 
the curve label,
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- Top - (T)

- Middle - (M)

- Bottom - (B)

- nth Layer - (#n)

- nth Ply - (Ply n)

And the integration points are appended after the surface layer, as @IP1, @IP2, etc. So, for 
Middle surface and integration point 2 the resultant test to be appended is ‘(M@IP2)’ for 
SHELLS and TSHELLS.

For BEAMs only the integration points are appended as #1, #2, etc to be in consistent with how 
T/HIS does this.

For SOLIDS only the integration points are appended as @IP1, @IP2, etc.

And for Max all, Min all, Mag all, Average all has been shortened to (Max), (Min), (Mag) and 
(Avg).

ZTF

 Case 57007

D3PLOT was sometimes slow to open models with many sets. This happened when there were a 
few sets with a lot of contents and many others with smaller contents. The speed has now been 
improved.
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2.3 T/HIS

2.3.1 Bugs fixed in 22.0

Data Components

 Case 55001

The component ‘Velocity_Nodal_Loads’ has been renamed to ‘Prescribed Motion’ for Boundary
Data. Issue fixed.

Datum

 Case 54529

Previously, moving or copying the last datum in a list could produce unexpected results. This 
issue has now been fixed.

 Case 54521

When creating a datum, if you were to not ‘Apply’ and then switch tabs on the panel, all 
information that you had pending within that panel would be cleared. Pending datum creation 
information is now retained between tab clicks until ‘Apply’ has been issued.

 Case 53881

The previous hard-wired limit of 256 for datums has now been removed from T/HIS. Any 
number of datums can now be created with machine specifications being the limiting factor.

FAST-TCF

 Case 56296

When we set x-axis and y-axis units for curves in T/HIS and write out a FAST-TCF script, the 
unit commands are now written correctly and on reading the script back into T/HIS, they are 
processed and set correctly.

 Case 55930

The FAST-TCF script was incorrectly written out for the operations that assign ‘X axis Unit’ and
‘Y axis Unit’ to the curves. This has been fixed now.

 Case 55926

When a FAST-TCF script referenced entities which do not exist, there were error curves created 
with a message ‘Curve not made successfully’. Now, the message says explicitly what item does 
not exist.
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Filename

 Case 56013

T/HIS preference ‘this*macro_directory’ can now work with a path which contains quotes.

Integration

 Case 54088

Previously, it was possible for a graphics window to be incorrectly sized if:

(1) A D3PLOT session was started for a model

(2) T/HIS was launched from within that session to produce a graph

(3) REPORTER was launched and the graph was ‘captured’

(4) The T/HIS window was undocked and moved into a different monitor with a different 
DPI

(5) The ‘resize’ button on that undocked window was used to give it the same aspect ratio as 
the captured image.

This was due to a complicated series of events calculating various aspects of window size and 
resolution incorrectly and has now been fixed.

 Case 53473

Previously, if debugging is turned on in REPORTER, some debug / diagnostic messages 
reported from T/HIS could be classified incorrectly as errors (sent to the stderr I/O stream).

This has been corrected by sending these messages to stdout.

JavaScript API

 Case 55782

Previously, T/HIS would crash when closing a JavaScript that had launched a curve Select/Pick 
window, via Curve.Pick() or Curve.Select(), while the Select/Pick window was still open. This 
has now been fixed.

Additionally, calling Curve.Select() or Curve.Pick() with the modal option set to true would still 
launch the corresponding Select/Pick windows as nonmodal. This has also been fixed.

Finally, launching a Pick window via Curve.Pick() while a select window (launched with 
Curve.Select()) was still open would prevent curve picking when returning to the select window, 
and vice versa. This has now been fixed.

 Case 55760

The Graph properties auto_xlabel, auto_ylabel and auto_y2label were returning Graph.OFF 
when they were ON and Graph.ON when they were OFF. This has been fixed.

Additionally, the Graph property y2label property would either return a blank string if there were
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no curves on the graph or the label of the first curve on the Y2 axis, rather than the Y2 axis label.
This has also been fixed.

 Case 53509

Dragging a box in the GUI builder window to select multiple widgets did not work when the 
cursor went outside the left-hand border of the window. This has been fixed.

 Case 52334

The function AddCurveID in the Graph class had an optional argument ‘no redraw’, which could
be an integer 0 or 1. This has now been replaced with a Boolean argument ‘redraw’, so that the 
graph is redrawn if this is set to true or omitted. This is more consistent with other places in the 
JavaScript interface.

Old scripts with the argument defined as integer will continue to work, but that syntax is no 
longer recommended for new scripts.

LSDA (binout)

 Case 55881

T/HIS will not crash anymore when a graph contains UTF-8 or CJK text and the T/HIS window 
is shifted from one screen to another.

Menus

 Case 55222

On Windows, any T/HIS child windows that are dragged out onto the desktop appear as mini 
preview windows when you hover over the [Th] icon on the Windows taskbar. Each preview has
an ‘X’ which if clicked on will close the window in question.

Previously, this went wrong in two ways:

(1) ‘Always there’ windows such as the Curve Manager in T/HIS disappeared and could not 
be re-instated – the dialogue box and graphics windows suffered the same fate.

(2) In some cases, the fact that the window was no longer there could cause a crash when 
T/HIS tried to use it because it did not ‘know’ that the window had been deleted.

This is now fixed. ‘Always there’ windows will now be removed from the desktop by remapping
them inside the T/HIS master window, so they are moved rather than deleted. Windows which 
can be deleted legitimately, for example Operate panel, is now deleted in a way which T/HIS 
‘knows about’ so there are no internal inconsistencies.

Operations

 Case 55579

When the colour for Injury Markers and Text was set to match the background, T/HIS previously
rendered them in the background colour, making them invisible. This issue has now been fixed, 
ensuring they are drawn in the foreground colour in such cases.
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Output

 Case 56109

T/HIS now adds extensions to output files when there no extension is provided. Issue fixed.

Read

 Case 56306

Previously for HDF5 files which contain very large amounts of metadata, some metadata would 
appear incorrectly within the attributes panel and potentially crash T/HIS. This has been fixed.

 Case 55598

T/HIS can now read stonewall energy data even if you do not select the RWFORC Card. Issue 
fixed.

 Case 55437

Previously when using ‘Pick Visible’ in the data reading object menu in the T/HIS link, selected 
items would not be sketched on the D3PLOT graphics window. This has now been fixed.

 Case 55088

Previously when trying to read a PTF file with a jobid into T/HIS, T/HIS would not pick up the 
corresponding readable files also containing the same jobid in the same folder. This is now fixed.

Recent Files

 Case 55684

When a file is dragged onto a T/HIS icon to open T/HIS, T/HIS will now remember the file for 
subsequent use in recent files dropdown menus.

Scripting

 Case 55614

Running a script by clicking on it in the script tree multiple times could cause an ‘Uncaught 
exception’ error if the script called Exit(). Now fixed.

Session

 Case 53877

T/HIS session file retrieval deletes existing graphs by default. However, a couple of other 
options are available: one to append to existing graphs and the other to produce an overlay.

The append and overlay modes had several issues and the following improvements have been 
made in that regard:

- The ‘Append’ mode was working like the default mode in the sense that existing graphs 
were being deleted. This has been fixed.
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- Overlaying a session containing fewer graphs on top of one containing a greater number 
would previously result in the number of graphs being limited to the smaller of the two 
numbers. This has been fixed. T/HIS will now add new graphs as needed.

- Layouts could be altered for the entire session resulting in the original graphs being 
moved or, in rare cases, overwritten. This has been fixed. The layout of the original 
session is now retained to the extent possible, with the new session adding on to that.

States

 Case 56216

During a D3PLOT-T/HIS linked session while the Timeline is active, selecting any Tidy option 
turns the Timeline ‘Off’ on all the graphs, but the Timeline check box still showed it as ‘On’.
This is now fixed. The check box will now update to be unchecked and the timeline is turned off 
when selecting any Tidy option from the T/HIS command menu.

T/HIS Link

 Case 53872

Previously, when using the D3PLOT-T/HIS link, T/HIS graphs and D3PLOT windows could 
disappear from pages if during the session T/HIS was swapped backwards and forwards between
docked and un-docked modes while custom (Advanced) page layouts were also in use. This has 
been fixed.

Units

 Case 55562

While performing the HIC operation, T/HIS previously assumed time values were in 
milliseconds and automatically converted them to seconds if the total time exceeded 1.

Now, it determines conversion based on curve units and prompts you if the maximum time 
exceeds 10. Issue fixed.

User Interface

 Case 55553

Updated the Properties tabs to display the ‘Curves’ tab, when accessed from ‘Properties...’ 
button (in Automotive → THIV, Automotive → HIC, Settings → General). Issue fixed.

 Case 54522

T/HIS no longer maps the slider in the Datum panel unless the number of datums is greater than 
number of rows in the panel. Issue fixed.

 Case 53477

Fixed an issue in the Read → Screen menu where some of the Read options were not disabled 
when you clicked Start Curve.
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Disabled all the read data buttons when start curve option is selected and enabled them back 
when end curve is selected.

 Case 50521

Shifted the ‘Confirm’ box for ‘deleting all curves’ closer to the cursor, for better accessibility. 
Issue is now fixed.

Volume III

 Case 55610

Support has been added for the new icfd_thermal.xxxx.dat file format from Ansys LS-DYNA 
R13.

 Case 54411

Added support for Scalar Potential in EM_NODOUT ASCII files and fixed reading EField 
components for 15 column-wide EM_NODOUT files.

Workflows

 Case 55639

Pressing the CORA button now picks up the script in the workflows directory instead of 
this_library. Issue fixed.

 Case 55480

When importing ISO-MME data, the ‘Unit’ header is used to automatically infer the units of 
each channel and when importing CSV data the Unit row is used. If unit data is not defined or 
cannot be interpreted, the unit system defaults to SI. Additionally, the new Import Configuration 
Window and accompanying Import Configuration CSV provide the ability to define the units and
correct curve naming, polarity and scaling before test data is imported.

 Case 54921

Made several improvements to the Pulse Index tool to show stiffness with respect to unit mass, 
added filtering and read velocity options along with various usability and accuracy 
improvements.

Write

 Case 55641

T/HIS outputs ‘End of line’ text in ISO-MME version 2.0 and not Version 1.6. Issue is now 
fixed.

 Case 55126

T/HIS will now be able to printout file paths longer than 80 characters in length in the dialogue 
window. Issue fixed.
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2.3.2 Bugs fixed in 22.1

Curves

 Case 57239

T/HIS could crash when doing some operations for curves that have several points which are 
exact multiples of 1010, this has been fixed.

 Case 56594

Curve labels displayed at ends of curves get chopped off. This has been fixed now.

Datum

 Case 57228

When reading in a datum file which contained point data into a fresh T/HIS session which had 
no previous read in datums, T/HIS would crash. This has been fixed.

FAST-TCF

 Case 55875

When reading a FAST-TCF file that references an include file, T/HIS previously failed to 
replace variables within the include file path. This issue has been addressed. The system now 
scans and replaces variables before attempting to read the include file.

Graphics

 Case 56629

Using the ‘Tidy’ button could result in the right-hand edge of the dialogue window overlapping 
slightly the left-hand side of the Global commands window. This would correct itself if the 
master application window was resized or if the vertical bar defining the border of the right-hand
panel was moved. Now fixed.

Graphs

 Case 57634

The last graph created by the Pulse Index workflow sometimes did not have a title until you 
manually refreshed the graphics. It now updates automatically.

 Case 57004

If a graph was moved/dragged to change the order on a page, then when you clicked on the graph
tool bar belonging to another graph then that graph number was changed/updated with the last 
moved graph. Now fixed.
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JavaScript API

 Case 57684

A modal window invoked from JavaScript that used UTF-8 encoding and non-western characters
could, in some circumstances, end up being hidden on the screen behind other windows when 
first mapped. Because it was modal, i.e. input was locked to that window, it could appear to lock 
up the user interface. Now fixed.

 Case 56535

Added missing Units constants to the JavaScript API.

Labels

 Case 55998

When a label is displayed on a curve, for example Max value (controlled in ‘Properties’) it is 
possible to move this label around the graphics window by dragging it. Previously it was 
possible to drag it entirely out of the graphics window making it disappear altogether. This also 
meant that it could not be dragged back in because it could not be selected.

Dragging of such labels is now restricted to within the graphics window.

Manual

 Case 57207

Added the missing ‘Online’ option in Help → Online/HTML.

Output

 Case 56726

T/HIS ISO-MME configuration files can now process operations which require multiple inputs.

Program Crash

 Case 57156

When resizing the Curve Properties panel in T/HIS such that the slider disappears and then 
resizing it once more so that the slider reappears, T/HIS would crash. This has been fixed.

Session

 Case 57272

When writing a session file from a linked D3PLOT-T/HIS session with model rereads and/or 
deleting models, T/HIS could crash. The crash has been fixed, but linked sessions with deleted 
models or models open only in T/HIS are not supported so these may not reload correctly.
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T/HIS Link

 Case 56900

Creating a large number of graphs in a linked D3PLOT-T/HIS session mapped the graph 
switches in view below the Tools panel. This has been fixed.

User Interface

 Case 56139

The tick boxes for summary properties showed a mixed state in the UI when they have different 
values in the active graphs. This has been fixed.

Utilities

 Case 56516

When altering the line width via the dialogue input line ‘/utils lw’, T/HIS would crash. This has 
been fixed.

Volume III

 Case 54407

Ansys LS-DYNA R14 (and later) runs using *EM_DATABASE_NODOUT can now output 
‘em_nodout_001.dat’ to ‘em_nodout_999.dat’ files corresponding to *OUTLV on the keyword. 
T/HIS would not recognize this as an output as this was originally intended to just output 
‘em_nodout.dat’. As the output for these files are the same for R14-R16.2, now it takes the first 
file found in the model directory and uses that for reading.

This will have to be revisited for Ansys LS-DYNA versions beyond R16.2 when output between 
these files will differ depending on which *SET_NODE each *EM_DATABASE_NODOUT is 
using.

Workflows

 Case 57503

Updated Ansys LS-DYNA to ISO-MME to output MME headers according to version e.g. 2026 
or 2024.

Write

 Case 57499

In Write → ISO-MME if you typed in a folder into the output textbox that did not exist there 
were two issues:

1. All the text was wiped from the textbox

2. On Windows, clicking the folder button would open an old version of the directory 
selector dialogue box
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Both issues have been fixed.
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2.4 REPORTER

2.4.1 Bugs fixed in 22.0

Capture

 Case 55682

Changes made in the ‘Edit D3PLOT Dialog’ or ‘Edit T/HIS Dialog’ before capturing will now 
correctly be loaded in D3PLOT and T/HIS.

 Case 47783

After setting the job file of a T/HIS item as empty, reopening the T/HIS Edit Dialog would 
previously restore the empty job to the default value. Now, it will remember the empty job file as
expected.

Deleting

 Case 55569

REPORTER no longer crashes when deleting a page using the right-click menu of the page 
navigation buttons.

Edit

 Case 56015

The spinbox used to specify Variable precision has now been made larger to ensure visibility of 
its value.

 Case 53765

The positioning of dialog boxes should now exhibit a more predictable behaviour: they are either
centred relative to their parent dialog box or relative to the mouse release point.

FAST-TCF

 Case 55863

REPORTER can now capture the minimum value on generating a T/HIS item, and on reloading 
the item back to T/HIS. Issue fixed.

Filtering

 Case 53841

The filtering of the ‘Choose a Template’ and ‘Choose a page’ dialog boxes is now fixed and
works more intuitively.
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Graphics

 Case 56017

The logic for drawing rectangles and ellipses when holding the Shift and/or the Ctrl keys has 
now been improved.

 Case 55518

REPORTER handles invalid files better when trying to import an item into the template.

JavaScript API

 Case 55648

Unicode characters are now correctly rendered in the JavaScript API.

PDF

 Case 54152

A ‘QThreadPipe: internal error’ message no longer gets printed to the command line when you 
open a PDF document on Linux. Issue fixed.

 Case 54102

The new features buttons on the splash screen dialog will now point to the correct pages in the 
new features PDF document.

Pages

 Case 56119

The page thumbnails in the page navigation bar now update automatically when you change the 
grid visibility. Issue fixed.

 Case 56023

The page navigation bar now updates correctly when you traverse your report/template by 
selecting items via the REPORTER item tree in D3PLOT and T/HIS.

 Case 55570

REPORTER now correctly displays the generation order number of items on the master page.

 Case 55374

The page thumbnails in the page navigation bar now update automatically when you capture 
from D3PLOT, T/HIS, and PRIMER. Issue fixed.
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Program Crash

 Case 55749

The logic for reordering pages by dragging and dropping page navigation thumbnails has now 
been improved. Issue fixed.

 Case 55723

REPORTER now properly handles any modifications (creation and deletion) to your captures via
the old method whenever you create or convert to a new D3PLOT item.

 Case 55555

REPORTER no longer crashes when you convert to the new capture method after editing the 
existing captures of your D3PLOT item.

 Case 55063

REPORTER will no longer crash if the reporter_library folder contains no templates/pages or if 
it contains invalid files.

Qt

 Case 55483

When opening REPORTER files with items missing a font name, a warning will be logged, and 
a default font name will be assigned. Issue fixed.

 Case 55062

REPORTER will no longer crash if the reporter_library folder contains no templates/pages or if 
it contains invalid files.

Read

 Case 53055

There is now better error handling for importing invalid files into REPORTER.

Template Files

 Case 55687

The GTR, Euro NCAP, and C-NCAP Head Impact templates were throwing errors when only 
the child list was provided. Issue fixed.

Text

 Case 55636

In the Font Substitution Dialog, if you choose to make the same replacements for other templates
opened during the session, the option to preserve the original fonts and styles when saving the 
template will also apply to all templates. Issue fixed.

                    
DOCUMENT3

Page 71



Oasys Ltd LS-DYNA Environment Release Notes
Version 22.1

User Interface

 Case 56063

The Category and Value drop down lists in the ‘Edit Template Properties’ menu will now have 
sorted items. Issue fixed.

 Case 55880

When creating/opening a template, the REPORTER icon will no longer be duplicated in the top 
left corner of the main window. Issue fixed.

 Case 55674

When first opening REPORTER, the ‘Choose a Template’ dialog box will no longer load 
duplicated tabs if you open and close it several times in quick succession. Issue fixed.

 Case 55486

The Window::GetNumber() function from the JavaScript API will now display the correct GUI 
theme for the number field.

 Case 55478

Support for different DPI displays has been improved. Menus will now scale more appropriately 
with changes in resolution and scale.

 Case 55235

Previously, when closing REPORTER while having multiple unsaved templates open, if you 
chose to cancel the operation, REPORTER would remain open, but the dismissed templates 
would also remain behind as separate windows. This has now been fixed.

 Case 54699

Duplicating a page, generating a page, or importing an item onto a page via the JavaScript and 
Python APIs will now set the template corresponding to that page as active. Issue fixed.

 Case 53630

The options in the filters tree of the ‘Choose a Template’ and ‘Choose a page’ dialog boxes will
always be visible now, regardless of machine resolution and scale. Issue fixed.

 Case 52237

Picking a screen colour now works when picking from another screen. Issue fixed.

 Case 52190

The text on script buttons will now have a more appropriate font size of 8 pts. Issue fixed.
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Variables

 Case 56071

In T/HIS, if the variables for an item have been modified and then you select a different item in 
the item tree, an information popup is displayed with options to capture, ignore or cancel. 
Previously, no default behaviour was defined. This is now fixed: the capture button is 
highlighted and is selected if you click Enter on their keyboard. 

 Case 54335

REPORTER can now identify report/template variables more accurately and makes sure to 
account for any formatting strings following the variable name. Issue fixed.

2.4.2 Bugs fixed in 22.1

Capture

 Case 57721

When launching D3PLOT from a D3PLOT item in REPORTER with a non-existent job file, 
D3PLOT would write an error message to the dialog box when the information box was 
dismissed. This issue is resolved.

 Case 57372

D3PLOT or T/HIS could launch on capture even when their corresponding dialogs returned an 
error from one of their input fields. REPORTER now prevents D3PLOT or T/HIS from 
launching in this situation.

 Case 57196

REPORTER did not obtain the correct capture type when capturing a D3PLOT item of type 
‘Blank’. REPORTER now displays the correct capture type in the Edit D3PLOT item dialog.

Formatting

 Case 57468

Kanji fonts were missing on Linux, causing incorrect text rendering. Additional mapping for 
Microsoft YaHei and Noto Sans has been added to the font mapping table to support Kanji 
characters.

General

 Case 56756

File paths containing spaces caused errors when launching D3PLOT. This has been resolved. 
REPORTER now automatically wraps the selected job file path in quotation marks in the Edit 
D3PLOT dialog, ensuring compatibility with file paths that contain spaces.
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Integration

 Case 56832

REPORTER would sometimes send the same command twice in a row when linked with 
PRIMER, D3PLOT or T/HIS. When generating an item or entire document, this could lead to 
the other program failing to revert to its previous state prior to generation and instead flushing all
models and data from memory to appear like a fresh session. This has now been fixed so the 
commands are no longer incorrectly issued twice and PRIMER, D3PLOT and T/HIS will 
correctly revert to the state they were in before generation.

Pages

 Case 57194

Pasting into the master page caused REPORTER to exit the master page unexpectedly. This 
behaviour has been corrected.

 Case 56816

REPORTER only supported inter-page scrolling previously. The scroll wheel now supports 
intra-page scrolling. If you are at the bottom or top of the page, using the scroll wheel will jump 
to the next or previous page, respectively.

PowerPoint

 Case 57223

Fixed a crash that could occur when writing a T/HIS item to PowerPoint.

Process

 Case 56663

Corrected the logic for updating page thumbnails. REPORTER now updates the page thumbnails
correctly for actions done and undone in the master page, regardless of whether the current page 
is a master page or not.

Standard Templates

 Case 56792

The measurement grid origin in the MPDB compatibility assessment deformation calculation 
was not consistent with the Euro NCAP protocol for the LSTC barrier model. This discrepancy 
has been resolved, and the grid now starts at y = 10 mm, z = 0 mm (in the barrier coordinate 
system) rather than y = 0, z = 0. Improvements were also made to the robustness of the 
deformation calculation.
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Template Files

 Case 57649

Corrected a typo (‘duringt’ → ‘during’) in the IIHS MDB (Structure Only) workflow templates.

 Case 57025

Corrected the logic for updating page thumbnails. REPORTER now updates the page thumbnails
properly when a script is not executed correctly on load.

Undo

 Case 57374

Fixed an issue preventing Undo working correctly with changed cell border widths inside the 
table.

User Interface

 Case 57735

When running REPORTER on Linux with certain PDF readers, if the ‘All new features’ button 
on the splash screen was clicked after previously having viewed the New Features PDF, it would
reopen on the last viewed page instead of returning to the first page of the PDF. This has now 
been corrected to align with the behaviour on Windows.

 Case 57426

REPORTER has been updated to correctly apply the chosen software theme to undocked dock 
widgets, ensuring the appropriate background colour is displayed.

 Case 55747

Changing the master page colour did not apply the colour to all pages. This issue has been 
addressed. New pages will now, by default, inherit the background colour from the master page. 
When editing page properties of the master page, the title field will now be disabled.

 Case 55244

Page reordering was limited to the visible area due to a lack of auto-scrolling. This issue has 
been resolved. The page navigation bar now scrolls automatically when dragging a page button 
to the top or bottom, allowing you to reorder pages beyond the visible area.

Variables

 Case 57075

Fixed a crash that could occur when output was being written to the Logfile while page 
thumbnails were being generated.
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 Case 57044

T/HIS variables were not saved correctly. REPORTER now correctly saves the variables 
captured with your T/HIS graphs to the report/template.

 Case 56766

REPORTER no longer crashes when you reopen the variables dialog after it was previously 
opened in full screen.

Workflows

 Case 57636

Fixed a text cropping issue on the Knee, Femur and Pelvis page in the Euro NCAP FFB 2017 
template.

 Case 57038

REPORTER now correctly displays unsaved changes that occur immediately when some 
template files are opened.
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2.5 SHELL

2.5.1 Bugs fixed in 22.0

User Interface

 Case 56111

The “recent” command line expression drop-down menu would sometimes showcase the path for
the last file submitted. This is now fixed.

User Defined

 Case 56326

The "user-defined" option can be added while editing the LS-DYNA command line via the text 
editor in the SHELL submission panel. But this "user-defined" option was not getting picked up 
while preparing the LS-DYNA command files. Fixed this.
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2.6 Oasys Suite – Cross Application

2.6.1 Bugs fixed in 22.0

Menus

 Case 52357

The ‘placement’ preference has historically allowed you to start PRIMER, THIS and D3PLOT 
on ‘left’, ‘right’, ‘top’ or ‘bottom’ screens. However, this did not consider a multi-monitor 
desktop and would start the code in that subset half-space of the master monitor.

This has now been fixed on both Linux and Windows. If a desktop is made up of two or more 
monitors, then a placement option will start the code on the monitor which is closest (in pixel 
space) to the designated location, which may not be the main monitor.

2.6.2 Bugs fixed in 22.1

Integration

 Case 53810

The appearance of the Post-Processor panel (in PRIMER) and the Pre-Processor panel (in 
D3PLOT and T/HIS) was inconsistent across all three programs. In some UI themes, information
was difficult to read, and it was not always clear whether the appropriate files were available. 
This has been fixed, and the panels will now behave more consistently.

JavaScript API

 Case 55425

Some menu panels in the T/HIS (and other) GUI are positioned in the foreground so that they 
remain visible in front of graphics and other windows, and do not get lost. This logic worked, but
it caused pop-ups from background windows to be obscured by these foreground windows, 
which was not the intended behaviour. This has been resolved.

The relative precedence of these two types of windows has been adjusted so that pop-ups will be 
visible even when invoked from a background window that is partially obscured.
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3 Enhancements
The enhancements and bug-fixes for each program have been broken down into a series of 
topics. Within each topic enhancements and bug-fixes are listed by case ID.

3.1 PRIMER

3.1.1 Enhancements in 22.0

Batteries

 Case 55732

Battery setup tool: Added the option to auto-generate an 2D array of unit cells and electrically 
connect (using *EM_ISOPOTENTIAL_CONNECT) the different unit cells together using a 
range of possible configurations.

 Case 55085

Battery setup tool: Added the option to swap the tabs for every other unit cell repetition.

 Case 54991

Battery setup tool: Created new post *END data to save battery definitions generated through the
‘Battery Setup’ tool as PRIMER entities. This allows the creation of multiple battery definitions 
within a model, as well as the ability to modify, delete, copy, orient and sketch an existing 
definition.

 Case 54988

Battery setup tool: Added the option to disable the automatic creation of *EM_MAT cards 
through the ‘Auto-create *EM_MAT cards’ tick box in the ‘Layers structure’ panel. This is 
turned on by default.

 Case 54986

Battery setup tool: Changed the default orientation so that the cell aligns vertically with the z-
axis instead of the y-axis.

The following now applies:

- Battery cell height aligns with the z-axis

- Battery cell width aligns with the y-axis

- Battery cell thickness aligns with the x-axis

 Case 54620

Battery setup tool:

- Added the option to move between different steps using either the newly added 
‘Previous’ and ‘Next’ buttons or the buttons at the top of the window. The tool will no 
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longer automatically jump to the next step when clicking on ‘Create’ as before, but it will
remain at the current panel to give the chance to check the settings and make any 
modifications (if needed) before proceeding to the next step.

- Added the option to undo creation of ‘Layers structure’, ‘Tabs structure’ and ‘Randles 
parameters’ using the ‘Undo’ button in each stage. Since some of the entities created 
during the ‘Tabs structure’ and ‘Randles parameters’ stages are dependent on entities 
created during previous stages, a warning pops up in case you attempt to delete entities at
a stage that would delete entities at following stages. Additionally, going back to the ‘1. 
Geometry and Scale’ panel and attempting to change the modelling scale would also 
require deleting all created entities in steps 2, 3 and 4 as these are dependent on the 
selected Randles modelling scale. A preference ‘battery_undo_warn’ was added to give 
the option to disregard these warnings.

- Added the option to make modifications in the ‘5. Analysis panel’ after clicking on 
‘Apply’. The ‘Apply’ button will get reactivated if any of the parameters in the panel get 
updated. However, unselecting a previously selected keyword will not cause its deletion, 
PRIMER will only add new keywords or update the parameters for selected keywords. 
Also, added a warning message that will popup if any of the selected Control keywords 
already exist in the model, to indicate that these will be overwritten. Another preference 
‘battery_overwrite_analysis_warn’ was added to give the option to disregard this 
warning.

- Added the option to reset all the parameters to their defaults at any stage.

 Case 54427

Battery Setup Tool: Improved the file selection for importing csv data in the startup panel. The 
file can now be selected by either writing its path in the textbox or using the file selector and 
clicking on ‘Read CSV’ imports the data.

Belts

 Case 55858

To visualise node sets on seatbelt-related keywords, the sketching of the following entities has 
been added: *ELEMENT_SEATBELT_SLIPRING SBRNID, 
*ELEMENT_SEATBELT_RETRACTOR SBRNID and *SECTION_SHELL EDGSET.

When these keywords are sketched, a vector is drawn from the first to the last node in the set to 
help visualise the direction of the node sets.

 Case 55510

When activating pelvis buckle rotations, a warning message will prompt you to set the path point
closest to the pelvis to the ‘Known position’ type to enhance rotation accuracy. You can 
permanently ignore this warning by setting the belt_ignore_pelvis_rotation_check preference.

Checking

 Case 26417

Check added for node on deformable to rigid part used by 
*CONSTRAINED_NODAL_RIGID_BODY.
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Connections

 Case 55218

Modular bolts using *SET_SEGMENT_GENERAL now have an option to combine sets using a 
parent *SET_SEGMENT_ADD and automatically make a contact when the modules are made.

 Case 54828

The Connections creation panel and the Connections table both have some user-interface 
improvements including the renaming of some controls and the rearrangement of menu layouts.

 Case 54676

Beam welds previously supported either 6 or 8 elements/ring in the heat-affected zone. Options 
have now been added for 10, 12, 14, and 16 elements per ring.

 Case 54644

PRIMER now supports 2-hexa and 3-hexa solid spotwelds.

 Case 54342

A new option has been added so modular bolts can be made using unique deformable parts for 
each bolt.

 Case 54327

Improvements to UI/UX for bolts and the Connections → Bolt/Joint → Create → Library → 
Select bolt module in particular.

A search bar has been added at the top of the popup.

 Case 51346

A new line connection type called arc-weld has been added. This is a contact-based weld for use 
on free edges or feature lines. Each connection has its own contact, and thickness is 
incrementally increased (to the defined limit) until all nodes are tied.

 Case 51339

Added options to filter connections by PARTs (‘by layer panels’ or ‘by attached panels’) while 
using the Connections Compare tool.

Contacts

 Case 55664

By default, nodes in tied contacts that are attached to the segment are excluded from the analysis 
meaning they will count as untied nodes.

A new option ‘treat attached nodes as tied’ will mean these are counted as tied nodes.
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 Case 55385

A new error check has been added for *CONTACT_AUTOMATIC_..._TIEBBREAK.
If the normals of the master segments point away from the tied node, an error is reported.

 Case 54437

Enhanced contact colours and sketching with user-defined colours for surf A and surf B have 
been added.

 Case 54200

Some enhancements have been made to the crossed-edge fixing tool. These include an extension 
of the shells selected for swap and an option to iteratively run the process to remove a wave front
of crossed edges.

 Case 51018

Added a way to visualize automatic contact surface wrapping around the shell edge with a radius
equal to one-half of the contact thickness. This can be done by selecting Part_Contact values in 
cut-section 2d capping and can also be visualized through the penetration check panel in 
wireframe mode.

Crash Test Setup

 Case 51572

Crash test setup: When using the rigidwall option for rigid frontal impact load cases, the sign of 
the rotation angle in the ROTATE row of the *DEFINE_TRANSFORMATION card that rotates 
the rigidwall by the impact angle, now always reflects the sign of the impact angle provided in 
the test settings.

Cut Section

 Case 55757

Positive and negative actions for cut sections can now be set as preferences 
primer*cut_section_pos_action and primer*cut_section_neg_action.

Database

 Case 52563

Added Xlsx option for exporting keyword data. Images can be written to excel file for keywords 
*DATABASE_HISTORY_BEAM, *DATABASE_HISTORY_NODE and 
*DATABASE_CROSS_SECTION.
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Dummies

 Case 55922

The positioning cable nodes selected for each HBM assembly are now added into a 
*SET_NODE and the reference for this set is mentioned in the update *ASSEMBLY card for the
*DUMMY definition of the HBM.

 Case 55921

A new functionality is created into the HBM positioning tools to facilitate ‘customised selection 
of nodes’ on HBM assemblies where the positioning cable elements can be attached.

 Case 55920

A new check button is added to the “Create Model” panel of the “Combined Dummy and 
Seatsquash” tool, to create a model ready for Ansys LS-DYNA positioning analysis “without” 
the encrypted HBM tree include.

 Case 55919

The *DEFINE_CURVE_SMOOTH definitions used in positioning cables elements for 
Dummies/HBMs have been replaced with *DEFINE_CURVE_FUNCTION to facilitate 
displacements of the positioning cables in a “sigmoid curve fashion”.

General

 Case 55488

The default for labelling nodes of sketched items has been changed to unconditional. The option 
for dynamic labelling remains but by default all labels will display even if they overwrite one 
another.

IGA

 Case 51960

Added functionality to read ASCII BASIS_TRANSFORM (BEXT) files.

 Case 51751

PRIMER now draws *IGA_SOLIDs both trimmed and untrimmed by *IGA_2D_BREPs.

Image

 Case 49951

Option added to read JFIF image format for backgrounds and watermarks.
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Include

 Case 55572

Multiple Include files can now be selected by shift clicking with the mouse when scanning 
Include files and selecting Include files to write.

 Case 54568

When PRIMER is reading an input deck and fails to find an include file, it gives you the option 
of skipping this file and continuing the read process. This works, but historically that leads to the
*INCLUDE statement being lost and not re-appearing in the keyword output file when the model
is written out.

From PRIMER 22.0 onwards, the default is now to remember the *INCLUDE statement. 
Internally, the include file will be a latent entry in the include tree, which can be read if the 
missing file is moved to the specified location. On keyword output, the *INCLUDE statement 
will be written but the underlying file obviously is not.

This is a change of behaviour, the original behaviour of forgetting the file can be reverted to via 
the [Model] Read, Options panel or via a preference.

JavaScript API

 Case 55905

JavaScript API methods have been added to the IGAShell and IGASolid classes, 
IGAShell.RedrawAll() and IGASolid.RedrawAll(), to redraw all IGA_SHELLs or IGA_SOLIDs
that have been affected by a change in any of their child IGA entities - e.g. when a control 
point(s), of a IGA_3D_NURBS_XYZ or IGA_2D_NURBS_XYZ, coordinates have been 
altered.

 Case 55778

Added “SetAssemblyPart”, “SetAssemblyPartSet” and “SetAssemblyNodeSet” to the JavaScript 
API Dummy class.

 Case 53513

Added JavaScript API for all IGA keywords available in PRIMER, except for keywords 
deprecated from Ansys LS-DYNA version R15.

 Case 52735

The memory for scripts is now automatically grown as required to run the script.

 Case 38800

For the JavaScript API Attached.SetEntity() method, added the option to select all entities or all 
constrained entities through the type argument using ‘ALL’ or ‘CONSTRAINEDALL’.
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Keyword

 Case 55866

*DAMPING_FREQUENCY_RANGE is now created with _DEFORM by default which is 
recommended for most applications.

 Case 54405

RFAC and PRU fields, and optional card (if PRU = 2) have been added to the 
*MAT_MODIFIED_HONEYCOMB as per the Ansys LS-DYNA R15 manual.

Keyword Editor

 Case 51303

Added keyword editor for *DEFINE_CPM_GAS_PROPERTIES.

Labels

 Case 55379

Testing with a 330m element ‘gigacasting’ model showed that while everything worked, albeit 
slowly, screen-picking things generally and nodes in particular could be very slow.

Graphics also did not run as fast as it could because it was not optimised for very large models.

Both problems have been improved:

- Picking generally is a bit faster for very large models, but node picking should be many 
times faster.

- Graphics should be substantially faster on high performance graphics cards where 
previously it was being throttled by other factors.

Load Paths

 Case 55539

Added a new ‘Auto-create’ feature to the Load path tool to easily create multiple 
*DATABASE_CROSS_SECTIONs through a selected structure.

Mass

 Case 55382

Added mass may now be set on the DT2MS calculation tool by specifying a target mass i.e. 
structural + added mass
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Orient

 Case 51747

PRIMER 21.0 implemented double precision for the storage of nodes and all internal 
transformations such as for *INCLUDE_TRANSFORM. However, the ORIENT panel, used for 
interaction transformations, continued to use single precision for the input of transformation 
data, limiting the precision of this to ~7 sig figs.

PRIMER 22.0 now uses double precision for all ORIENT panel input and the underlying 
processing of this is now also double precision throughout.

Output

 Case 44703

Previously, PRIMER was not able to write out the include files in a format different from the 
master file. So, we added a ‘File format’ option per include file to map the file format panel in 
the SELECT INCLUDE FILES TO WRITE window. This can be used to select different formats
(ASCII/Binary/Compression) per include file while writing out.

Parameter

 Case 55042

The ‘pow’ syntax (for ‘to the power of’) can now be used in the parameter expression editor.

Part Table

 Case 49273

It is now possible to automatically resize columns in Part Table and Part Compare Table to fit 
their content. This can be done by double-clicking on the right-hand edge of the column header. 
There are also two new buttons, one to automatically resize all columns in the table to best fit 
their content and one to reset the size of all columns back to the same size. This is similar to 
existing behaviour in the Keyword Editor.

Part Replace

 Case 54221

PRIMER 22.0 now has a new preference ‘spotweld_remake_auto_remove_layer’. When it is 
TRUE, PRIMER will automatically remove layers that failed to connect when remaking 
spotwelds.

Pedestrian

 Case 53595

The pedestrian markup tool can now be viewed without loading in a model, including being able 
to browse the available protocols without selecting the outer parts.
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Renumber

 Case 55695

Connections may be grouped by setting strings for title and/or user data. The connection object 
menu filter allow selection by this string to retrieve a group of connections.

Scripting

 Case 54387

The ability to open the help manual from the SBA, Luggage Retention, and Sled Test tools input 
panels has been added.

In the SBA tool, a check has been added for constrained extra nodes, and PRIMER now throws a
warning if any node in the set either belong to NRB, Rigid bodies or refers to a part that is rigid.

An additional option to constrain the inertia loading device using rigid bodies has been added.

In the luggage retention tool, the sliding planes have been constrained to the bottom rigid plate 
such that they all move together.

A check for constrained extra nodes has been added such that PRIMER now throws a warning if 
any node in the set either belong to NRB, Rigid bodies or refers to a part that is rigid.

Tables

 Case 53582

The option drop-down on the table edit panel now allows existing _NONE table to be converted 
to _2D. Additionally, model check warning and autofix are now available to fix all _NONE 
tables in the model by converting to the preferred _2D format.

Views

 Case 55441

It is now possible to set the target and eye position from the JavaScript and Python APIs.

Volume III

 Case 53914

Added the drawing and picking functionalities for *EM_ISOPOTENTIAL and modified the 
sketching to connect composite nodes by lines.

Added the drawing, sketching and picking functionalities for 
*EM_ISOPOTENTIAL_CONNECT.

Added a new entry in the ENTITIES panel that controls the drawing and labelling of 
*EM_ISOPOTENTIAL and *EM_ISOPOTENTIAL_CONNECT.

Added *EM_ISOPOTENTIAL to the list of ‘find attached through’ types within the Attached 
tool.
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Xref

 Case 54403

*EM_MAT_001, etc. reference a structural material. This will reference one or more Parts. The 
xref viewer when applied to the *EM_MAT will now show these parts. It may be considered a 
virtual reference.

3.1.2 Enhancements in 22.1

Checking

 Case 56826

LS-DYNA checking has been enhanced. INI+490 and STR+268 errors have been added to 
DynaOutputReader.xml.

Crash Test Setup

 Case 51299

Crash Test Setup now supports a third ‘admin’ settings location, which can be set using the 
preference ‘primer*crash_test_setup_admin_loc’. This allows you to define a shared folder for 
vehicle settings that can be accessed across teams. The tool now reads vehicle settings from 
system, user, and (if defined) admin locations. Admin settings are read last, so they are the ones 
used in the test.

Scripting

 Case 57737

Joint selection has been updated so you can screen pick joints.

New functionality to help ensure you cannot pick the same joint for two separate text boxes on 
the four-bar link has been implemented.

Seats

 Case 55179

In Tools → Safety → Seat squash → Squash → Setup LS-DYNA analysis, the option ‘Try to 
improve Tet meshes’ when using the Seat squash with LS-DYNA method has been removed as it
has no relevance in this context. 
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3.2 D3PLOT

3.2.1 Enhancements in 22.0

Contour

 Case 54666

Added new Data Plot Refresh controls to the Data panel to automatically refresh data bearing 
plots when a top-level setting is changed. Also added a button in the panel to manually refresh 
them if desired.

Cut section

 Case 55758

Positive and negative actions for cut sections can now be set as preferences 
d3plot*cut_section_pos_action and d3plot*cut_section_neg_action.

 Case 51049

The rows on the cut section forces table can now be sorted by their value in a given column. This
is done by clicking on the respective column header, where two clicks give backwards sorting. 
This is the same behaviour as in the Write table.

Envelope

 Case 22898

In D3PLOT 22.0, you are now able to save and retrieve envelope data.

As well as interactive controls, we have provided an option to save envelope files via the batch 
command line option ‘-env_out’ along with a settings file. This may be particularly useful for 
automatic runs where more complicated and lengthier calculations are required. Once generated, 
the envelope file can be retrieved in a new session within seconds.

More information about this feature can be found within the manual as well as the new features 
documentation.

Graphics

 Case 53165

D3PLOT 22.0 now fully supports the Cohesive solid element formulations where the node 
ordering follows the Thick Shell order instead of the normal solid order.

Previous versions of D3PLOT would display these elements but would draw the wireframe 
overlay (and free edges) incorrectly. Any results plotted on the elements were correct.
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 Case 52798

Lighting states for windows and annotations are now reflected in D3PLOT Viewer when 
viewing GLB files exported from D3PLOT.

 Case 47698

Improved part-screen logic to be responsive according to changing window size and number of 
fixed labels present in the header and contour bar areas. Added a preference to let you choose 
from one of the Full Screen, Part Screen and Report format.

Manual

 Case 56204

In most JavaScript API and Python API classes, GetFromIndex starts at index 0. This has now 
been clarified in the manual without changing the functionality in D3PLOT.

Movies

 Case 51557

For MP4 movie files, it is now possible to specify a target file size in megabytes. This is only a 
target and not a certainly achieved exact size. In our internal testing the actual file sizes are a few
percent smaller than the target.

Performance

 Case 55194

D3PLOT has been tested with a “Gigacasting” model containing 330 million elements and, after 
changing some internal address arithmetic from 32 bit to 64 bit, it now handles very large 
models.

Preferences

 Case 52710

Preferences to control the initial visibility for the following have been added:

- sph_visibility controls SPH elements
- des_visibility controls DES elements
- cpg_visibility controls CPG particle visibility

All are on by default.

Recent Files

 Case 52986

A “Recent files” dropdown list has been added to the Background Images/Movies menu.
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3.2.2 Enhancements in 22.1

Volume III

 Case 57296

While playing an animation in D3PLOT, it was possible to generate multiple messages about 
rescanning contour levels if you clicked on options in the Data Menu even if these options did 
not affect any of the contour values.

These rescanning events did not affect any results but affected the playback speed of the 
animation, which has been resolved.
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3.3 T/HIS

3.3.1 Enhancements in 22.0

Data Components

 Case 55752

Recent versions of Ansys LS-DYNA now write the Normal force for Rigidwall Segments to the 
RCFORC file. T/HIS can now read these from both the LSDA (binout) and ASCII files.

 Case 54574

T/HIS 22.0 supports the new data components written to the BINOUT and ABSTAT_CPG files 
for models containing CPG Airbag definitions.

Filtering

 Case 53056

T/HIS’s filters are up to date according to SAE Journal 211 199503. T/HIS performs Forward-
Backward Filtering to avoid any phase shift in its results.

JavaScript API

 Case 55772

A y_axis property has been added to the Curve class to get/set which Y axis the curve is using, 
either Curve.Y1_AXIS or Curve.Y2_AXIS.

 Case 55759

A show_y2axis property has been added to the Graph class to turn the Y2 axis on and off.

 Case 55564

The function assigned to the Window onClose event can now return false to prevent the window 
closing if required.

 Case 54612

New functionality has been added to the JavaScript API that allows you to both set and query 
model and display units. The relevant methods can be accessed from the Model and Units classes
respectively.

Operations

 Case 48542

T/HIS now supports Occupant Load Criterion (OLC) calculation via the Automotive menu.
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 Case 48427

T/HIS now supports Tibia Index (TI) calculation via the Automotive menu.

 Case 53115

T/HIS now supports Damage (DMG) calculation (a measure of head injury) via the Automotive 
menu.

Units

 Case 55754

To define the unit system for curves imported from ‘.cur’, ‘.csv’, or ‘ISO channels’, ‘Curve Unit 
System’ dropdowns have been added to the T/HIS Curve, CSV, and ISO Read menus.

Workflows

 Case 55584

Added support in Automotive Assessments and REPORTER Templates for IIHS Front SOB 
2024 and IIHS Side MDB 2024.

 Case 50020

Added a new Curve to ISO-MME workflow tool to export T/HIS curves in ISO-MME format on
the fly. The same option can be accessed via Write → ISO-MME → Curve.

Write

 Case 55165

Created some new controls to open the Curve to ISO-MME tool from the Write panel. There are 
two radio buttons: Curves and Models. Curves is the default which allows you to generate the 
ISO-MME results through the Workflows tool. Models sets it to the original method where you 
need to select the model(s) and a configuration file.
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3.4 REPORTER

3.4.1 Enhancements in 22.0

JavaScript API

 Case 55883

The REPORTER JavaScript and Python APIs now feature a new property ‘generating’ for the 
Template, Page and Item objects.

 Case 54431

The Item.RemoveCondition method has been added to REPORTER’s JavaScript and Python 
APIs to allow you to remove any conditions that have been set to items. Also, providing a name 
is now mandatory when creating conditions.

 Case 54255

REPORTER now supports ES6 modules, which give JavaScript built-in support for modular 
programming using the import and export keywords. REPORTER also now accepts the ‘-js’ and 
‘-js_arg’ command line arguments for running JavaScript scripts with arguments.

Pages

 Case 54626

The page buttons in the page navigation bar now have a new right-click menu option that allows 
you to edit the page properties.

 Case 53897

The thumbnails for the page buttons in the page navigation bar now update more efficiently 
when switching between design and presentation views.

 Case 53104

We now support ‘.ortx’ and ‘.orrx’ file formats when importing a page into your current 
template/report.

 Case 52803

REPORTER now displays the page number and title underneath the page button in the page 
navigation bar and as a tool tip whenever you hover over the button.

 Case 52652

The Del key functionality has now been enhanced in REPORTER. If any items are selected on 
the template, pressing the Del key will delete those items (existing behaviour). However, if you 
navigate between pages using the page buttons in the page navigation bar and have not interacted
with the template, pressing the Del key will delete the current page. A faint border will appear 
around the page button to indicate that the Del key will delete this page.
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Program Crash

 Case 55853

REPORTER will now attempt to write the logfiles in case of a crash. If no log file command 
argument has been provided, these will be written to a reporter.error file.

 Case 55677

REPORTER now makes it easier to report crashes, by pre-populating an email with stack trace 
information for you.

Python API

 Case 53910

Improved the way optional arguments are handled in the Python and JavaScript APIs.

Undo

 Case 50876

REPORTER now includes undo and redo functionality for most actions, providing the ability to 
correct mistakes and return to previous states easily. An undo history view is also available, 
allowing you to easily navigate through previous states within your session. The undo stack will 
be cleared whenever you generate or run scripts.

Workflows

 Case 52051

Automotive Assessments Euro NCAP MPDB (Occupant Assessment) updated to 2024 to include
DAMAGE modifier.

 Case 51485

Support for UN ECE R94, R95, R135, and R137 has been added to the Automotive Assessments
Workflow and associated REPORTER templates.
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3.4.2 Enhancements in 22.1

Pages

 Case 51766

REPORTER now appends any imported pages immediately after the current page, rather than at 
the end of the template or report.

Standard templates

 Case 47820

Added the second row occupants to the C-NCAP MPDB Occupant template.

Workflows

 Case 56507

The Automotive Assessments workflow now supports FMVSS 208, with separate options and 
REPORTER templates for HIII-5F, HIII-50M, and Low Risk Deployment.
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3.5 Oasys Suite – Cross Application

3.5.1 Enhancements in 22.0

Program Crash

 Case 55688

The Oasys Suite has always produced dump files on Windows platforms when it crashes, but 
these have been a bit hidden away into the AppData/local/temp directory which is hard to find.

Dump files sometimes give the ability to work out why the software crashed so receiving them is
valuable. Therefore, a new capability to create an email, preconfigure it with information and 
attach the dump file has been created in Oasys 22.0.

It must be stressed that this is not sent automatically. You must choose to create the email, and 
once it appears in your mail client software, choose to send it. This behaviour is configurable so 
if you wish to turn this feature off, you can do so.

Workflows

 Case 54655

Added DRIVER_HEAD_EXCURSION assessment type to Automotive Assessments 
Workflows.

 Case 54631

Support for Validation Criterion 2 required for EuroNCAP Far Side Virtual Testing Protocol has 
been added in Automotive Assessments Workflows.

3.5.2 Enhancements in 22.1

Licensing

 Case 57152

Historically any of our licensed software which loses connection to the LMX licence server for 
more than 10 minutes would terminate unconditionally.

This behaviour has been modified so that instead of termination the process goes into a 
‘suspended’ state which does not lose any data or work but locks the user interface so that no 
further work can be done. You can choose to wait until the connection is restored or save data 
and terminate. When the licence server connection is restored, the suspension is ended, and you 
can continue working as if nothing has happened.

One exception to this is when the software is working in ‘tty’ (i.e. non-GUI) mode, which is 
most likely to occur when working in batch. In these situations, the old behaviour of termination 
after 10 minutes still applies since suspending a batch session, possibly indefinitely, is 
undesirable behaviour.
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